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ABSTRACT

Obsahem této diplomové prace je hydrotechnické posouzeni moznych uprav
vybraného toku Janovického potoka, nachazejici se ve StfedoCeském kraji.
Pfedmétné posuzované misto se pak nachazi v katastralnim uzemi obce Vaclavice,
vzdalené 5 km od mésta BeneSov. Za poziti nekomeréniho software HEC-RAS
(River Analysis System), verze 4.0, mUzZzeme pak pomoci nameéfenych hodnot
vypocitat mozna rizika.

Cilem této prace je pak navrzeni moznych protipovodriovych opatfeni na
vybraném Useku toku Janovického potoka v obci Vaclavice, s vybranim té

nejvhodnéjsi pro moznou realizaci.
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ABSTRACT

The content of this thesis is to assess the possible hydro-flow adjustments
selected Janovice Creek, located in the Central Region.
The subject site is considered, then located in the cadastral municipality Vaclavice,
5 km from the town of BeneSov. For the ingestion of non-commercial software HEC-
RAS (River Analysis System), version 4.0, you can use our measurements to
calculate the risks.

The aim of this paper is suggesting possible flood protection measures on a
selected section of the flow stream in the village Janovice Vaclavice with selecting

the most suitable for possible implementation.
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1. UVOD

Uvodem bych chtél nastinit pro¢ jsem si viibec vybral uvedené téma.
Zajmové uzemi Janovického potoka, se nachazi ve StfedoCeském kraji,
v katastralnim Gzemi obce Vaclavic. Jak je znamo celé Gzemi Ceské republiky
prochazi kazdoro¢né fadou povodrovych situaci. V nami feSené lokalité k témto
pfirodnim jevim dochazi nepravidelné v intervalech pfiblizné jednou za 5 let a to
zejména v obdobnych tani snéhu a v obdobi vydatnych srazek. | kdyz povodnové
stavy v zajmovém Uzemi Janovického potoka v mnohych pfipadech zpUsobili pouze
materialni $kody, pokusim se touto praci nastinit mozné feSeni z hydrotechnického
pohledu formou nékolika moznych uprav Janovického potoka.

V dalSi ¢asti Diplomové prace se budu vénovat naméfenym hodnotam, které

nam s pouzitim software HEC-RAS stanovi zaplavové uzemi na vybraném useku.



2. CiL PRACE

Cilem Diplomové prace je v €asti literarni reder8e nastinit problematiku
povodni z obecného a historického hlediska, jak celé Ceské republiky, tak i v nami
vybraném useku. Zaroveni budou v Diplomové praci nastinény mozné druhy
znamych povodni, vyskytujicich se na uzemi Ceské republiky s uvedenim té&ch, dle
problematika vlivu samotné povodné z hlediska urbanizace s uvedenim srazkového
stavu na nasem uzemi.

V dal$i ¢asti bude charakterizovano zajmové uzemi, tedy uzemi Janovického
potoka. Zde bude dale uvedeno povodi toku, hydrologické poméry toku a tvar a
vyuziti udoli. V neposledni fadé zde bude zminka o objektech, nachazejici se na
celém Janovickém potoce v celé své délce s uvedenim povodriové situace.

Soucasti prace budou v dalsi kapitole uvedeny mozné Upravy vodnich tokl a
s tim spojena tato problematika. V posledni Casti literarni reSerSe bude zminéna
problematika matematickych modeltu v hydrologii s konkrétnimi pfiklady software,
které tyto matematické modely pocitaji.

Vzhledem k tomu, Ze tato Diplomova prace je feSena formou projektu bude
dalSi ¢ast vénovana hydrotechnickému posouzeni Janovického potoka v useku
f.km 9 azf.km 6, cozZ je Uzemi nachazejici se v katastralnim uzemi obce Vaclavice.
Samotné hydrotechnické posouzeni bude provedeno pomoci software Hec — Ras,
verze 4.0, ktery nam vyhodnoti zaplavové Uzemi pfi rliznych N-letych pritocich.

Zavér Diplomové prace bude vénovan vysledkim z programu Hec — Ras,
ktery nam ur€i zaplavové uzemi. Soucasti zavéru bude také okrajové nastinéni
budouci vystavby dalnice D3 v okoli Janovického potoka a mozného vlivu na vodni
tok. Uplnym z&vérem bude navrZzeno mozné feseni z hydrotechnického pohledu na

moznou Upravu Janovického potoka v obci Vaclavice.



3. METODIKA

3.1. Ziskané teoretické poznatky

Samotny sbér teoretickych poznatkG bude spocivat ve shromazdéni a
prostudovani co nejvétSiho mnozstvi dostupnych materiald tykajicich se
Janovického potoka. Z pohledu praxe to pak znamena ziskani potfebnych dat
z povodi Vltavy, jakozto z Méstskych, potazmo Skolnich knihoven. Vlastni méfeni a
vysledek bude proveden pomoci software HEC - RAS. Pro ziskani co
nejpfesnéjsSiho pohledu na danou problematiku bude vtextu pouzita vlastni

fotodokumentace.

3.2. Literarni reserse

Tato ¢ast bude obsahovat povodné z obecného pohledu. Dale samotné
druhy povodni a faktory je ovliviiujici. Dale zde bude vénovana pozornost ochrané
pfed povodnémi a t&m nejrozsahlej§im povodnim v novodobé historii Ceské
republiky. Dale zde bude nastinéna problematika moznych uprav na vodnim toku.
V neposledni fadé zde bude detailnéjSim zpUsobem popsano zajmové uUzemi.

Podrobnéji samostatné kapitoly 4., 5., 6. a 7.
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4. POVODNE

Povodné jsou na Uzemi Ceské republiky z hlediska pfirodnich katastrof ty
nejrozsahlejsi, které se u nas vyskytuji.
Definice povodni Ize definovat podle nékolika zptsobd. Podle CSN 1975

zni :

.Pfechodné vyrazné zvySeni hladiny toku, zpUsobené nahlym zvétSenim
pritoku anebo do¢asnym zmensenim prutocnosti koryta (napf. ledovou zacpou)”.
(CSN, 1975)

Podle pozdé&jsi normy CSN 1983 zni definice povodné takto :

»~Jedna se o fazi hydrologického rezimu vodniho toku, ktera se mlze vicekrat
opakovat v riznych ro¢nich obdobich; vyznacuje se nahlym, obvykle kratkodobym
zvétSenim pratokd a vodnich stav(l; je vyvolana desti nebo tanim snéhu z oblevy*.
(CSN, 1983)

Povodné Ize dale definovat napf. podle zakona €. 254/2001 Sb., o vodach a

0 zméné nékterych zakonu (dale jen ,Vodni zakon®) takto :

.,Povodnémi se rozumi prechodné vyrazné zvySeni hladiny vodnich toku
nebo jinych povrchovych vod, pfi které voda jiz zaplavuje uzemi mimo koryto
vodniho toku a mUze zpUsobit Skody. Povodni je i stav, kdy voda mize zpUsobit
Skody tim, Ze z urCitého Uzemi nemulze doCasné pfirozenym zpusobem odtékat
nebo jeji odtok je nedostateCny, pfipadné dochazi k zaplaveni uUzemi pfi

soustfedéném odtoku srazkovych vod®. (zakon €. 254/2001 Sb.)

4.1. Historie povodni v Ceské republice

Z historického pohledu se prvni zminky o samotnych povodni datuji do
obdobi mezi 12. stol. — 14. stol. V minulosti se data o povodnich shromazdovala a
dale predavala k dalSimu vyuziti pomoci dennich zaznamu o pocasi, osobni
korespondenci, specialnimi tisky, ufednimi hospodaiskymi zaznamy, novinami,
obrazovou dokumentaci a védeckou praci. Nasledné si lidé tyto vétSinou pisemné
materialy vzajemné pfedavali k dalSimu vyuziti. napf. prvni zminka o vétSi povodni

z roku 1342 uvadi, Zze doSlo ke strzeni Juditina mostu v Praze, dale v roce 1496,
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1784 a 1890, kdy byl naopak nejvice poSkozen Karliv most, kdy v roce 1890 doslo
dokonce ke strzeni celkem 3 obloukd z mostni konstrukce uvedeného mostu.
V prabéhu celého 20. stoleti, s vyjimkou roku 1903, kdy doslo k povodni na uzemi
Slezska, se jiné vaznéjSi povodné nevyskytly. V tomto obdobi je navic nutné
konstatovat, Ze dochazelo ze strany Clovéka k zasadnim zasahim do krajinného
razu v podobé, vykacovani lesu v okoli udolnich niv, které dokazali zadrzovat vodu,
a dale Clovék zacal vyuzivat uzemi, ktera byla po dlouho dobu nevyuzita z ddvodu
povodni, avSak vzhledem k tomu, Ze k povodnim po delSi dobu nedochazelo, zacal

Clovék toto uzemi dale vyuzivat. (Brazdil a kolektiv, 2005)

4.1.1. Historie povodni v zajmovém uzemi

V celém toku Janovického potoka nejsou k dispozici udaje o zaplavovém
uzemi historické pfirozené povodné. Na druhou stranu je mozné v daném pfipadé
konstatovat, Ze nami zpracovavaném useku a i na jinych €astech Janovického
potoka, v katastralnim uzemi obce Vaclavice, dochazi i kdyZz k ojedinélym, ale
pravidelnym drobnym zaplavam. K témto pfirodnim katastrofam na vybraném toku
dochazi v pravidelnych intervalech 5 let a to z dGvodu zejména tani snéhu. Vydatné
desté se zde vyskytuji spiSe sporadicky. PFi zasazeni uvedené lokality zminénou
pohromou navic dochazi k zaplavovani vzdy téch samych uzemi. V nékterych
pfipadech dojde i k vytopeni €asti nemovitosti jako jsou sklepy, dilny, garaze,

stodoly popfipadé zahrady nachazejici se svym umistnénim nejblize toku.

4.2. Druhy povodni

Podle pficiny vzniku uvadéla CNR (1975, 1983) bez definiéniho vymezeni
povodné desStové, snéhové a smiSené. Pod pojmem desStova povodeni se zde
tanim snéhu a deStovych srazek. Zviastnim pfipadem jsou ledové povodné,
zpusobené doCasnym zmenSenim prutocnosti koryta v disledku ledovych jeva napf.
ledovou zacpou. Vznik desStovych, snéhovych, smiSenych nebo ledovych povodni je

zpravidla zpusobena nékolika pfirodnimi meteorologickymi pri¢inami.
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- povodné destové

- povodné snéhové

- povodné smisené

- povodné ledové

Povodné Ize dale charakterizovat napf. na povodné pfirozené a povodné
zvlastni. Do pfirozenych povodni lze pak zafadit nami zminéné, kterym

v nasledujicim textu budou vénovany samostatné kapitoly.

Povodné zvlastni je povoden zplsobena umélymi vlivy, j. situace, jez mlze
nastat pfi stavbé nebo provozu vodnich dél, které vzdouvaji nebo mohou vzdouvat,
zejmeéna pfi naruSeni télesa vzdouvaciho vodniho dila, poruse hradicich konstrukci
vypustnych zafizeni vodniho dila nebo nouzovém feSeni kritickych situaci z hlediska

bezpecnosti vodniho dila. (Brazdil a kolektiv, 2005)

4.2.1. Povodné destové

Destové povodné jsou vyvolany kapalnymi srazkami a podle zpusobu
vzniku, doby trvani a intenzity desté je Ize dale délit na povodné z trvalych srazek a
povodné z pFivalovych srazek.

DeStové povodné ztrvalych srazek jsou vazany zpravidla na jedno az
vicedenni trvalé srazky, které jsou spojené s nékterymi vybranymi srazkové
vyznamnymi synoptickymi situacemi.

Destové povodné z privalovych srazek souviseni se srazkami s kratkou

dobou trvani, avsak s velkou intenzitou, zpravidla doprovazenymi bourkami.
4.2.2. Povodné snéhové
Snéhové povodné vznikaji nahlym tanim snéhové pokryvky pfi kladnych

teplotach v zimnich a v jarnich obdobich, které mohou byt doprovazeny i ledovymi

jevy.
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4.2.3. Povodné smisené

SmiSené povodné jsou zplsobeny kombinaci tani snéhu a deStovych
srazek, které mohou byt doprovazeny taktéz snéhovymi jevy a jsou vazany na dosti
rozdilné povétrnostni situace pfinadSejici vzimé a na zacatku jara otepleni

s kladnymi teplotami, doprovazené Casto i siln&jSim vétrem.

4.2.4. Povodné ledové

Ledové povodné vznikaji zpravidla po obdobi déle trvajici mrazi se
zamrzem fek, kdy nasledné nahlé otepleni mlize zpuUsobit odchod ledu, pficemz
kdyz dojde ke tvorbé ledovych zacp a napichud, muze doCasné zmenseni pritoénosti

koryta zpusobit vyrazné vzduti vodni hladiny.

V Ceské republice se v8ak mohou vyskytnout i specifické povodné bez pfimé

vazby na meteorologickou situaci. (Brazdil a kolektiv, 2005)

4.3. Faktory ovliviujici povodné

Vznik a pribéh povodné je ovliviiovan predevs§im meteorologickymi faktory,
a to pfedbé&znymi a pfi€innymi.

Predbézné faktory plsobi nékolik dni az mésicu pfed vznikem povodné.
Patfi mezi né zejména nenasycenost povodi, vySka snéhové pokryvky a jeji vodni
hodnota, promrznuti pady apod. Z hydrologickych predbéznych faktorld hraje
ddlezitou roli mira naplnéni koryt vodnich tok( pfed zacatkem povodné.

PFicinné meteorologické faktory pusobi nékolik hodin az dnd pfed vznikem
povodné jako jeji spoustéci mechanismus.

Kromé&  uvedenych  faktord  jsou povodné  podminény  také
fyzickogeografickymi a antropogennimi faktory v povodi. V souvislosti se vznikem a
pribéhem povodni jsou rozhodujici vlivy - intercepce, detence, infiltrace a objem

ficni sité.

intercepce — zadrzujici uCinek vegetace ba padajici srazky, dany druhem, hustotou
a vyvojovym stavem porostu, ktery mize navic zpomalovat pohyb vody na povrchu
a tim prodluzovat dobu mozného vsaku

detence — schopnost zpomalovat odtok ze spadlych srazek naplfiovanim depresi
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terénu, coz mize vést k do¢asné akumulaci vétsiho mnozstvi vody v rovinném nez

ve sklonitém terénu

infiltrace — vsak vody do pldnich vrstev s navySenim podzemnich vod, ktery zavisi

na typu pudy, jeji mocnosti, porovitosti, obsahu humusu, jejim nasyceni vodou atd.

objem Ficni sité — plnéni koryt tokd v€etné mnozstvi vody vtlatené do pfilehlych
podpovrchovych ¢&asti bfehové zény v dusledku hydrostatického tlaku a objemu

inundaci, tj. rozliv do inundacnich tzemi podél toku. (Brazdil a kolektiv 2005)

Jak jiz bylo nastinéno, kromé uvedenych klimatickych vlivl ma na povoden
vlivi zména v Uzemi. Zména v Uzemi ma na povoden vliv jak z pohledu rozsahu, tak
z pohledu prabéhu. Zvliastni pozornost je nutné vénovat GUzemi udolnich niv, coz
jsou oblasti podél toku, které jsou nebo v nedavné minulosti byly zasahovany
zaplavami.

Z nedavné historie muzeme vypozorovat nékolik rozsifenych zasahu do
krajiny, které jsou dnes povazovany za faktory umocriujici problém povodni na
nasem Uzemi. Jedna se o regulace koryt vodnich tokd, zejména jejich narovnani,
zemédélskou €innost a osidlovani udolnich niv.

Dale je mozné uvést, Ze upravy na samotném vodnim toku problém povodni
nijak nefedi, pouze ho posouvaji dale po proudu. | kdyZ je tato skutecnost
vSeobecné znama, pfi realizaci souCasnych regulaci koryt vodnich tokl jakozto
protipovodriovych opatfenich se na ni ¢asto zapomina.

Zemédélska cCinnost v ploSe povodi vyznamné ovliviluje odtokové poméry.
Za minulého rezimu doslo ke sceleni zemédélskych pozemkd, k jejich melioracim a
odstranéni dalSich krajinnych prvkl ( napf. mezi, remizkd apod.), které byly schopny
zadrzovat vodu. Z tohoto davodu je dneSni reten¢ni schopnost znaéné snizena.

V souvislosti s povodnémi se opakované zmirfiuje zejména jev vodni eroze,
které ohrozuje zejména zemédeélské pozemky s vySSim sklonem, které jsou
nehospodarné obhospodafovany. Vodni eroze vznika zejména v obdobi pfivalovych
srazek, kdy voda s sebou odnasi velké mnozstvi pidy a splavenin, coz ma za
nasledek zaneseni vodnich tokl a nadrzi bahnem. Nasledkem toho je pak to, ze se
toto bahno musi nechat odstranit.

Povodné tedy nelze eliminovat, Ize vS8ak zménou vyuzivani uzemi do jisté
miry snizit frekvence jejich vzniku a dramati¢nost povodriovych pribéhl. Vhodnym
vyuzivanim udolnich niv je mozné vyznamné sniZit potencial pro vznik povodriovych
8kod. (Camarova, Jilkova a kolektiv 2006)
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4.4. Ochrana pred povodnémi

Samotnou ochranu pfed povodnémi Ize obecné charakterizovat jako mozné
pfedchazeni pfimého ohrozeni zivota, zdravi a majetku ob&anu a spolecnosti a
Zivotniho prostfedi pfi povodnich provadéna pomoci systematické prevence,
zvySovanim retencni schopnosti povodi a ovliviiovanim prabéhu povodni. Samotna
ochrana pfed povodnémi je pak dale fizena pomoci tzv. povodnovych planl, a
v pfipadé vyhlaseni krizové situace tzv. krizovymi plany. Témito plany se pfi
samotném vyhlaseni fidi povodriové organy, které zabezpeduji celkovou koordinaci
¢innosti podle zminénych pland. V pfipadé vyhlaseni napf. nouzového nebo
krizového stavu pak povinnosti pfechazeji na pfislusné Uzemni organy krizového
fizeni. (Kovar 2004)

4.4.1. Povodnové stupné

Povodriovy plan stanovuje tfi stupné povodriové aktivity pfi povodiovych a

ledovych jevech:

1. stupen - stav bdélosti

2. stupen - stav pohotovosti

3. stupen - stav ohrozeni

1. stupen (stav bdélosti) nastava pfi nebezpeli povodné a zanika, pominou-li

priciny takového nebezpedi, pficemz za nebezpeci povodné se povazuje:

- upozornéni nebo vystraha pfedpovédni sluzby

- nahlé tani snéhové pokryvky

- srazky vétsi intenzity

- velké narustani nebo hromadéni ledu v toku

- dosazeni uréeného stavu na vybranych hlasnych profilech, stanoveného
v povodriovych planech

- dosazeni meznich hodnot sledovanych jevl a skute€nosti z hlediska
bezpeclnosti vodniho dila

- provozni situace na vodnim dile, které mohou vést k mimofadnému vypousténi

nebo nefizenému odtoku, pfi kterém je dosazen stav odpovidajici prvnimu stupni
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povodriové aktivity na vybraném vodoctu

PFi tomto stupni je zaroven zahajovana Cinnost hlasné a hlidkové sluzby.

2. stupen (stav pohotovosti) se vyhlaSuje v dobé vlastni povodné na zakladé
udaja hlidkové sluzby a zprav predpovédni a hlasné sluzby, pfiemz za povoden se

povazuje:

- dosazeni ureného stavu na vybranych hlasnych profilech, stanoveného
v povodriovych planech

- prechodné vyrazné stoupnuti hladiny vodniho toku, pfi kterém hrozi jeho vyliti
Z koryta nebo se voda z koryta jiz rozléva a muze zpUsobit Skody

- pfechodné vyrazné stoupnuti hladiny vodniho toku, pfi kterém se voda z koryta jiz
rozléva a muze zpUsobit Skody

- prechodné stoupnuti hladiny vodniho toku pfi sou¢asném chodu ledd, pfipadné
vlivem vytvofeni ledovych bariér;

- pokracujici nepfiznivy vyvoj bezpecnosti vodniho dila odvozeny podle hodnoceni
sledovanych jevl a skute€nosti v ramci vykonu technicko-bezpeénostniho dohledu

- mimofadné vypousténi vody nebo nefizeny odtok z vodniho dila, které vyvolavaji
umeélou pratokovou vinu, pfi které maze byt dosazen stav odpovidajici druhému

stupni povodriové aktivity na vybraném hlasném profilu

PFi tomto stupni se aktivizuji povodriové organy a dal8i u€astnici ochrany
pfed povodnémi, uvadéji se do pohotovosti prostifedky na zabezpe€ovaci prace a
podle moznosti se provadéji opatfeni ke zmirnéni prabéhu povodné podle

povodnového planu.

3. stupen (stav ohrozeni) se vyhlasuje pfi:

- dosazeni uréeného stavu na vybranych hlasnych profilech, stanoveného
v povodriovych planech

- bezprostfednim nebezpeci ohrozeni majetku a zivotl v zaplavovém uzemi

- vzniku kritické situace na vodnim dile podle vyhodnoceni technicko-
bezpecnostniho dohledu pfi dosazeni kritickych hodnot sledovanych jevl a
skutecnosti, pokud hrozi havarie dila doprovazena nebezpec€im vzniku prdlomové

viny
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- mimofradném vypousténi nebo nefizeném odtoku z vodniho dila, které vyvolavaji
umélou pratokovou vinu, pfi které je dosazen stav odpovidajici tfetimu stupni

povodriové aktivity na vybraném vodoctu

Pfi tomto stupni se provadéji zabezpe€ovaci a podle potfeby zachranné

prace. (Ministerstvo zivotniho prostfedi, 1997)

4.5. Povodné v Ceské republice

Vyskyt meteorologickych a klimatologickych extrému je vysledkem pfirozené
variability zemské atmosféry. V ni se pod vlivem rdznych pfirodnich a
antropogennich faktord odehrava fada slozitych a vzajemné se ovliviujicich
fyzikalnich a chemickych procesu, které v interakci s aktivnim povrchem mohou vést
k vyskytu extrémnich stavd rizného ploSného rozsahu a trvani. Zatimco
v pfirodnich ekosystémech jsou takovéto extrémy vcetné jejich ucink( soucasti
jejich pfirozeného vyvoje, v kulturni krajiné zpusobuji pfi stale slozitéjsi infrastrukture
lidské spole¢nosti mnohdy velké materialni 8kody i ztraty na lidskych Zivotech. Jak
ukazala statistika z Mnichova (Minchener Rick 1999), vzrostl pocet velkych
prirodnich katastrof mezi léty 1950-1959 a 1990-1999 asi Ctyfikrat, ekonomické
ztraty asi ¢trnactkrat a ztraty pojiStoven (od 60. let) asi patnactkrat.

Ceska republika byla v poslednich letech postizena velkymi pfirodnimi
katastrofami hned nékolikrat. Plati to zejména o povodnich na Moravé a ve Slezsku
v ervenci 1997 (52 obéti, Skody za 62 miliard K¢&), ve vychodnich Cechach
v ervenci 1998 (6 obéti, $kody za 2 miliardy K&) nebo v Cechéach v srpnu 2002 (17
obéti, odhadované Skody pfes 100 miliard K¢&), ale i o suchu na jizni Moravé
v dubnu az Cervnu 2002 (Skody za 5 miliard K&). K tomu pfistupuji dalSi obéti a
Skody pfi bleskovych povodnich v dasledku pfivalovych destu, pfi vichficich,

krupobitich a dalSich meteorologickych a klimatologickych extrémech.

4.5.1 Nerozsahlej$i povodné v novodobé historii Ceské republiky

Na celém uzemi dnedni Ceské republiky do$lo od pod&atku vzniku
samostatné Ceské republiky k fadé ni¢ivym povodnim. Pro nastinéni jsem vybral 3,

dle mého nazoru ty nejhori povodné, a to z hlediska jak materidlnich Skod, tak

bohuzel i z hlediska ztraty lidskych Zivotu.
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Prvni katastrofalni povoden se stala vroce 1997 na Moravé a probéhla
zhruba v rozpéti 5. Cervence 1997, kdy pfisla prvni velkd voda a trvala do 16.
gervence 1997. Zasazené Uzemi bylo na Moravé, Slezsku a na vychodé Cech.
Zaplavy zasahly také sousedici uzemi Polska, Slovenska a Rakouska. Povodnova
vina z Odry se niCivé projevovala i na jejim dolnim toku v usecich hranice s
Némeckem. Povodern na Moravé se tak stala soucasti katastrofy evropskych
rozméru. Pro Uplnost uvadim celkovou $kodu, kterou tato povoderi zpUsobila — 63

miliard K¢.

Druha katastrofalni povoden se stala v srpnu 2002 a postihla nase hlavni
mésto Prahu. Tuto povoden lze povazovat za jednu z nejvétSich udalosti svého
druhu v historii Ceské republiky. Prvni pFivalové desté se na Uzemi ceské republiky
dostavili jiz dne 7. srpna 2002, coz zpusobilo rozvodnéni hladin jiho€eskych fek, kdy
na zakladé tohoto museli vodohospodafi odpoustét naplnéné prehrady (Lipno,
Rimov, Husinec). Zaroven zadinaji pretékat rybniky. Od uvedeného data se hladiny
malych, ale i velkych Fek kazdym dnem zvy3ovaly, coz mélo za nasledek zatopeni
velmi rozsahlého uzemi po celé Ceské republice. napf. v Praze, na Vitavé byl
nameéfen pratok 5300 m3*s, coz byl nejvysSi pratok od povodné zroku 1875.
V celkem 7 krajich byl vyhlaSen stav nouze. Z materialniho pohledu zpuUsobila
povodeni ze srpna 2002 Skodu bezmala 74 miliard K&, z toho pfes 6 miliard byla

zpusobena Skoda v prazském metru.

Treti katastrofalni povoden se stala v obdobi od 22. ¢ervna 2009 do 4.

v

nejvice postihla zejména JihoCesky, Zlinsky, Olomoucky a Moravskoslezsky kraj.

Celkova Skoda pak byla vycCislena na ¢astku 5,6 miliardy K&.

4.6. Vliv povodni z hlediska urbanizace

Z hlediska urbanizace mize mit povoden vliv na rezim a zdroje podzemnich
vod, dale na funkci vodovodnich siti a na funkci stokovych siti.

(Patera & kolektiv, 2002)

4.6.1. Vliv povodné na rezim a zdroje podzemnich vod

Vv,

vyskytuji v hydrologickém rezimu nejen vodnich tokl, ale i podzemnich vod.
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Vyznam téchto vyjimecénych hydrologickych jevi je dan tim, Ze jejich vyskyt ma
obvykle nepfiznivé dlsledky pro veskerou hospodarskou cinnost a nékdy i
katastrofalni nasledky. NejvétSi zajem se v minulosti soustifedil na povodrové
situace vzhledem k obrovskym S8kodam, které zpUsobuji. Velké naroky na
zasobovani obyvatelstva, pramyslu i zemédélstvi vodou vyvolaly potfebu zabyvat se
negativnimi dusledky vlivu povodni na rezim a zdroje podzemnich vod.

PFi¢inou vzniku povodné je vyskyt vyjimecnych meteorologickych situaci,
majici zpravidla za nasledek nékteré nezadouci pravodni jevy i v rezimu
podzemnich vod. Patfi knim v prvé fadé extrémné rychlé zvySovani hladin a
zvétSovani zasob mélkych podzemnich vod a poskozovani vodnich zdroja
s naslednym omezenim nebo uplnym vyfazenim provozu, coz je mnohdy pfi€inou
drastického omezovani dodavek pitné vody pro obyvatelstvo i jiné ucely. Kromé
toho maji nepfiznivy vliv na péstovani zemédélskych plodin i na ostatni vegetaci
v krajiné i na vétSinu staveb a nékteré procesy probihajici v krajiné.

Ochrana vSech vyznamnych zdroji podzemni vody, které slouzi
k hromadnému zasobovani obyvatelstva pitnou vodou, proti negativhim uc€inkiim
povodni ne nezbytna. K tomuto ucelu je nutno vyuzit vdechny dostupné technické
prostfedky. Ve vétSiné pfipadl nelze spoléhat pouze na pfirozenou ochranu zdroj(
podminénou geologickou stavbou a hydrologickymi poméry uzemi, v nichz se
nachazi. PFi feSeni zplsobl ucinné ochrany téchto vodnich zdroju by se mélo
vychazet z vysledkl specialnich hydrologickych studii a expertiz zaméfenych pravée

na tyto problémy. (Patera & kolektiv, 2002)

4.6.2. Vliv povodné na funkci vodovodnich siti

V pfipadé povodni je tfeba mit na zfeteli, Ze nesmi byt dana lokalita, ktera
byla zasazena, ohroZzena od vzniku omezeni ve formé& dodavani pitné vody
vodovodnim potrubi, pfiéemz v uvedeném pfipadé musi byt jesté kontrolovana
kvalita dodavané pitné vody. Dale je mozné podle dosavadnich studii konstatovat,
Ze podzemni zdroje pitné vody jsou daleko méné zranitelné ve srovnani se zdroji
povrchovymi. Za timto ucelem je nutné provadét kontrolu, zda nebyly naruseny
nebo poruSeny objekty na vodovodni siti nebo vodarenské fady. PFi rekonstrukci
vodovodni sité v uzemi se zvySenym vyskytem povodni musime provést nezbytna
opatfeni, abychom zamezili moznym negativnim rizikim. Samotné vedeni potrubi
se nesmi ukladat na vodovodni stranu mostnich konstrukci, nebot by mohlo dojit

k porudeni plovoucimi pfedméty pfi povodnich. Dale je nezbytné v pfipadé vzniku
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povodné zajistit dodavky elektrické energie do COV a to z divodu, aby napf.
nedoslo ke znehodnoceni kald.

Zavérem je nutné podotknout, Ze ve méstech a v obcich je tfeba zlepSovat
odtokové poméry, aby nedoslo pfi povodnich ke zhorSeni kvality vody.
(Patera & kolektiv, 2002)

4.6.3. Vliv povodné na funkci stokovych siti

V oblastech dotéenych extrémnimi hydrologickymi jevy byva nezbytné tfeba
navrhnout opatfeni pro projektovani objektl stokovani a ¢isténi odpadnich vod
vzhledem k témto situacim. Proto je tfeba v ramci budoucich projektd navrhovat
nejen opatfeni na 100-letou vodu, ale posoudit je i na vétsi maximalni pritoky a
odhadnout jimi zpusobenych Skod. Jako podklad v tomto pfipadé slouci vodovodni
stavy upfesnéné po velkych povodnich minulych let. Statické vypoc&ty nadrzi provést
i pro vétsi maximalni pratoky s posouzenim na vztlak ( tj. provést zatézovaci stav
béhem stavby nadrze, kdyZ je nadrz prazdna béhem rekonstrukce a pfipadné jesté
neni naplnéna kapacita Cistirny odpadnich vod a nadrz neni vyuzivana. Na 100-
letou vodu posoudit odleh&ovaci komory pfed &istirnou i na dalSich mistech stokové
sité.

Zavérem je mozné uveést a to ndm davaji za pravdu i studie z poslednich let,
Ze nejvice jsou ohroZeny vytokové objekty. Skodam z nich nelze zabranit, ale Ize
zmensit nebezpedi jejich poskozeni vhodnym umisténim v toku a opevnénim koryta
kamennou dlazbou nejen v bezprostiedni blizkosti vytokového objektu, ale i delSim
useku toku. (Patera & kolektiv, 2002)

4.7. Srazkovy stav na Gzemi Ceské republiky

Srazkové Uhrny jsou na Uzemi Ceské republiky vzhledem k jeji velké
vertikalni Clenitosti velmi proménlivé v ¢ase a prostoru. Vliv nadmorské vysky na
srazkové uhrny se projevuje jen u nejvysSich pohranicnich pohofi. Vyznamné jsou
navétrné a zavétrné efekty horskych prekazek.

Roéni srazkové uhrny kolisaji na tzemi CR od 410 mm po vice nez 1700
mm. Na vice nez 60 % uUzemi potom ro¢ni uhrn srazek dosahuje 600 - 800 mm.
Nejsussi oblasti Ceské republiky jsou v okoli Kladna, Zatce a kolem Ripské tabule,
kde jsou srazkové uhrny niz§i nez 500 mm. Vyrazné nizké srazkové uhrny jsou
v zapadnich Cechach, kde spadne primérné roéné& méné nez 550 mm. Smérem k

vychodu srazkové uhrny rostou, na Ceskomoravské vrchoving jsou primérné
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srazkové uhrny okolo 700 mm. V pohrani¢nich horach pak mohou dosahovat i vice
nez 1400 mm.

Ve vztahu k zemédélské vyrobé a vegetaci celkové je rozhodujici rozlozZeni
srazek b&hem roku. Roéni chod srazek v Ceské republice Ize charakterizovat jako
kontinentalni s maximem v lété (40 % srazek) a s minimem v zimé (15 % srazek).
Na jaro pak pfipada 25 % a na podzim 20 % srazek. Nejvice srazek tedy spadne od
kvétna do srpna a vlbec nejdestivéjSim meésicem byva zpravidla Cervenec. V
nizinnych oblastech Moravy se projevuje tzv. druhotné maximum v fijnu, zde je
spolehlivé prokazano ovlivnéni Jaderského more. Minimum srazek v roénim chodu
se vyskytuje v CR zpravidla v Unoru, ale v horskych oblastech to muze byt i v
bfeznu.

Absolutné nejdestivéjsim mésicem v historii na tzemi Ceské republiky byl
Cervenec 1897, kdy v Nové Louce v Jizerskych horach naprselo 656 mm. Pfitom
vice nez polovina tohoto mnozstvi spadla v priibéhu jediného dne a to 29.7.1897,
kdy spadlo 345 mm srazek, coz je stfedoevropsky rekord.

Primérny pocet dnli s méfitelnymi srazkami vys$simi nez 0,1 mm, kolisa od

90 dn(, ve velmi suchych oblastech az po 240 dnd v oblastech horskych.

4.7.1. Srazkovy stav v zajmovém uzemi

Rocni srazkovy stav ve vybraném uzemi se pohybuje v rozmezi srazek
500 — 800 mm. (Vaclavické listy 2010)
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5. CHARAKTERISTIKA ZAJMOVEHO UZEMi

Janovicky potok je potok ve StfedoCeském kraji, levostranny pfitok feky
Sazavy, ktery do ni usti v Tynci nad Sazavou na fi¢nim kilometru 19,2 v nadmorské

vySce 255 m. Délka toku je 26,3 km. Plocha povodi méfi 159,2 km?2.

5.1. Povodi toku

Povodi Janovického potoka je soucasti povodi Sazavy, které nalezi
hydrologicky k povodi Vitavy, resp. Labe.

Celkova plocha povodi je 159,230 km?, délka udoli je 26,3 km. Lesnatost
povodi je 10%. NejvysSi misto v povodi Kopanina dosahuje vySky 592 m n.m.,

Geologicky pfinalezi povodi Janovického potoka do Ceského masivu oblasti
Kutnohorského kristalinika.

Geomorfologicky se povodi Janovického potoka nachazi v BeneSovské
pahorkating, ktera patfi do geomorfologického celku StfedoCeské pahorkatiny,
v subprovincii Cesko — moravské provincie Ceské vysoginy. (Souhrnna technicka
zprava GEFOS a.s., 2004)

5.2 Hydrologické poméry

Janovicky potok se fadi mezi vodni toky deStovo - snéhového typu.

Hydrologické poméry povodi se vyvijeji v zavislosti na hlavnich Ccinitelich
utvarejicich vodni poméry, tj. na srazkach, geomorfologii, geologické skladbé a
pudnim krytu. Primérny ro¢ni uhrn srazek v povodi je 615 mm.
V povodi neni zadny vyznamny odbér vody, ktery by vyrazné ménil hydrologické
pomeéry. Na horni ¢asti toku se nachazi rybni¢ni soustava, ktera maze mit vyznamny
vliv na transformaci povodrnové viny zejména v horni poloviné toku. Celkem je zde 7
rybnikud, z nichz 4 nejvétsi Hurecky, Libohostsky, Kamenny a Zrcadlo maiji celkovou
plochu 47 ha a objem 870 tis. m>.

Pro vypocet velkych vod v celé délce toku byly udaje CHMU rozdéleny do
dilgich usekl definovanych hlavnimi povodimi toku podle atlasu hydrologickych
pomérd CR. V horni &asti povodi byly dilgi useky uréeny podle pfitokl. (Souhrnna
technicka zprava GEFOS a.s., 2004)
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http://cs.wikipedia.org/wiki/Kilometr
http://cs.wikipedia.org/wiki/Povod%C3%AD
http://cs.wikipedia.org/wiki/Kilometr_%C4%8Dtvere%C4%8Dn%C3%AD

5.3 Tvar a vyuziti udoli

Nad Vrchotovymi Janovicemi prochazi koryto Janovického potoka svazitym
Uzemim s pfevazné zemédélskym vyuzitim. Na pfilehlych pozemcich jsou pole,
louky a v kratkych usecich les. Ve Vrchotovych Janovicich prochazi koryto toku
zameckym parkem. Zacina zde rybni¢ni soustava, ktera sestava ze 7 rybnik( na 6-ti
kilometrech délky toku. Pod touto rybni¢ni soustavou prochazi tok zatravnénou
udolni nivou Sifky cca 100 m az k soutoku s Nesvacilskym potokem. V f.km 11,6 —
12,7 pfiléha k pravému bfehu areal golfového hiisté. Déle tok vtéka do sevieného
zalesnéného udoli délky 2 km. Pod timto Usekem se udoli opét otevira a udolni niva
dosahuje Sifky do 200 m. V f.km 4,1 — 6,0 se nachazi soustava tfi nepratocnych
rybnikd. Janovicky potok je obtéka pfi pravé strané udoli. Posledni 4 kilometry
k soutoku se Sazavou ma udolni niva Sitku kolem 50 metr( a stfidaji se zde
zatravnéné useky s neobhospodafovanou pudou. (Souhrnna technicka zprava
GEFOS a.s., 2004)

5.4. Popis vybraného useku Janovického potoka

Nami hodnoceny usek Janovického potoka se nachazi ve StfedoCeském
kraji, na F.km 9,245 az 6,037, coz je usek v katastralnim uzemi obce Vaclavice.
Tento Usek se nachazi od osady Kozli az k rybniku Hamry. Do Janovického potoka
se v uvedeném useku pak dale vléva Prostfedni p., Luéni p., Vaclavicky p.,
Ferdinanduiv p. a Vatékovsky p.

Z vlastniho terénniho Setfeni v8ak bylo zjisténo, Ze vSechny pfitoky jsou ve
velmi Spatném stavu — zarostlé vegetaci, fiéni koryto zaneseno popadanymi stromy
apod. a hladina samotnych pfitokt v mistech Usti do Janovického potoka dosahuje

maximalni hloubky 30 cm s Sifi koryta do 1 metru.
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obr. . 1 Znazornéni zajmového uzemi Janovického potoka
5.5. Popis objektl na Janovickém potoce v celém svém toku

Na toku Janovického potoka je celkem 66 objektl. Jedna se o 1 zelezni¢ni
propustek, 33 silni¢nich mostl, hospodarskych prejezdd a propustkl, 16 trvalych
lavek, 7 rybni¢nich hrazi, 6 jezi a 3 stupné ve dné. (Souhrnna technicka zprava
GEFOS a.s., 2004)

5.5.1. Popis objektt v useku i.km 9 az f.km 6

V nami zvoleném useku, tedy v useku kolem mezi f.km 9 az f.km 6 se
nachazi celkem tfi vyznamnéjSi objekty, a to 2 Zelezobetonové silniéni mosty, a
zelezobetonova lavka. Dale se v katastralnim Uzemi nachazi nékolik nemovitosti,

pozemkd, stodoly a relativné nové vybudovana CistiCka odpadnich vod.
Zelezobetonové silniéni mosty

Prvni Zelezobetonovy silni¢ni most se nachazi na f.km 8,308. Jedna se o

zelezobetonovy most, ktery se nachazi na silnici Ill ¢. 11434 a je urCen pro

obousmérny provoz silni¢nich motorovych vozidel.
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obr. ¢.2 Silniéni most nachazejici se n f.km 8,308

Druhy Zelezobetonovy silniéni most se nachazi na f.km 7,029. Jedna se o

Zelezobetonovy most, ktery se nachazi na silnici Ill €. 10614 a je uren pro

obousmérny provoz silni¢nich motorovych vozidel.

obr. €. 3 Silni€ni most nachazejici se n f.km 7,029
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Zelezobetonova lavka

Zelezobetonova lavka se nachazi na F.km 6,904 a je uréena vyhradné pro

pési turistiku. Z hlediska konstrukce je dlouha 21 metrt a Siroka necelé 2 metry.

obr. &. 4 Zelezobetonova lavka nachazejici se n f.km 6,904

Cisti¢ka odpadnich vod

V roce 2007 byla v k.u. obce Vaclavice postavena Cisticka odpadnich vod
pro obyvatele obce Véclavice. PF vystavbé se samotna COV umistnila na
vyvySeninu zeminy, aby se vyhnula pfipadnym povodnim. O vhodnosti a uCelnosti

samotné vystavby jsme se sami pifesvédcili pfi zaplavach v roce 2006.
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obr. & 5 Povodné z roku 2006 (v pravém hornim rohu COV)

Popis pozemki, domtl, chat atd. v okoli atd.

Janovicky potok se vléva k prvnim obhospodafovanym mistdm na f.km 7,5
a jako posledni v zastavéném Gzemi se nachazi shora uvedenda COV, coZ je na
f.km 6,8. Na tomto Useku se v ohrozené oblasti fiéniho toku nachazi celkem 11
celoroéné obydlenych nemovitosti, dale celkem 10 zahrad, z nichz 4 zahrady jsou
pravidelné ohroZovany zejména pfi pfivalovych destich. Pro zajimavost bych rad
uvedl|, Zze se u F.km 7,1 nachazi nové vybudovana stavba - truhlarna, ktera se také
nachazi v zaplavovém uzemi, av8ak pfi stavbé bylo mySleno na pfipadny
povodnovy stav, a proto se majitel rozhodl o vystavbu 25 cm spodni obvodové zdi

nad hranici 100leté vody.

5.6. Povodiova situace na Janovickém potoku

Rozhodnutim Krajského Gfadu StfedoCeského kraje, odbor Zivotniho
prostfedi jako pfislusny vodopravni Ufad podle zakona &. 254/2001 Sb., ve znéni
pozdéjSich predpist, vramci své pulsobnosti, na navrh spravce vyznamného
vodniho toku, Janovického potoka, stanovil rozsah zaplavového uzemi, tj.
administrativné uréeného uzemi, které muze byt zaplaveno vodou pfi vyskytu

pfirozené povodné kolem vyznamného vodniho toku, Janovického potoka — f.km
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0,00 — 18,7. Stanovené uzemi se nachazi v katastralnim Uzemi obci Tynec nad
Sazavou, Krusi¢any, Vaclavice, PfibySice, BeneSov, Tisem, TvorSovice, Zahradka,
Rudoltice, Vrchotovy Janovice a KreSice u Olbramovic. Zaroven byla v daném
uzemi stanovena aktivni zona zaplavového uzemi. (Stanoveni zaplavového uzemi
Janovického potoka, 2005).

5.6.1. Ve vybraném uzemi
Nami zvoleny usek (f. km 9 az 6) se nachazi dle rozhodnuti Krajského ufadu

StfedoCeského kraje, odboru zivotniho prostfedi v zaplavovém uzemi Janovického
potoka. viz kapitola 5.6.
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6. MOZNE UPRAVY VODNICH TOKU

Moznych uprav na vodnim toku jako opatieni proti povodnim je cela fada, a
proto se v této kapitole budeme vénovat moznym opatfenim v obecné roviné. | kdyz
kazdy pfipad, kde se o jakékoliv protipovodfiové upravé uvazuje, je tfeba feSit
individualné. Dale je nutné uvést, ze je tfeba provadét i preventivni opatfeni a
pravidelné kontroly vodnich tok a tim pfedchazet k moznym negativnim

dusledkim.

V praxi se jedna o :

- udrzbu upravenych koryt a kanalt ve formé odbahnovani, se€eni a €isténi

- rozvifovani koryt stfidavymi vysadbami dfevin (stromy, kefe), jak vné koryta, tak i

v blizkém okoli koryta

- zmélcovani, rozvlhovani a substratova rehabilitace dna vodniho toku vkladanim
Stérkovych zahozu ve formé Stérku, kamenl a podobného materialu z pravé a levé
strany bfehu shazujici se do vné koryta, kdy cilem je zvySit Urovefi dna, rozvinit
proudnici, vytvofit brodova mista a vytvofit Stérkové trdlisté

- pomoci konstrukci z kamene a dfeva chranit urcCité pasaze brehl pred vymilanim
vodou, nebo naopak pomoci téchto konstrukci vhodné usmérnit proudéni vody tak,
aby nedochazelo k jejim rozlivim mimo koryto

- zvétSeni Ficniho toku jeho rozSifenim

- vicefunkéni feSeni Fiéniho prostoru ve formé konceptu pfilezitostné zaplavovanych

povodnovych parku

- budovat radéji strmé, konstruk¢né narocné brehy a co nejSirsSi fiCni koryta

- za béznych a malych pritok( udrzovat v koryté vétSi mnozstvi vody

- budovat povodfiova ochranna koryta, plochy pro povodriové poldry a retenéni

nadrze pfirodné blizkého razu
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- kompletni modelace nového fi¢niho toku

6.1. Sprava vodnich toku

V podminkach Ceské republiky jsou zaleZitosti vodniho hospodarstvi
rozdéleny do dvou resortll, a to resortd ministerstva zemédélstvi a ministerstva
zivotniho prostfedi. To je v souCasné dobé vSak nejvétsi problém, protoze se tim
omezuje efektivnost ucinénych opatfeni. Z tohoto dlivodu je nutné uvést, aby ve
spolupraci obou resortt doslo k nalezeni co nejvétSiho pocétu spoleénych cili a tim i

k vétSi efektivnosti.

6.2. Upravy vodnich toka v zastavéné oblasti

V zastavénych oblastech je zpravidla nutné dodrzeni dvou zasad — koryta by
meéla byt prutokové kapacitni, aby zastavéné okoli bylo co nejméné ohrozeno a dale
by méla tato vodni koryta byt stabilni, protoZe v zastavéné oblasti neni mnoho
prostoru pro jejich vyvoj do stran. V minulosti bylo téchto dvou podminek docileno

ve formé napf. zpevnénych vodnich kanald.

6.3. Opatreni prijata po povodni

Po samotné povodni je vhodné postupovat tak, aby se pfi odstrafiovani skod
vzniklych pfi povodni neudélalo jesté vice Skod, nez které zpusobila predesla
povoder.. Zmény po povodni by se méli hodnotit v souvislosti s konkrétnim Usekem
vodniho toku. V této fazi je nutné podotknout, Ze z pohledu vodniho toku je dale
nutné, zda se vybrany usek nachazi v zastavbé, popf. mimo zastavbu (ve volné
krajing). Ve volné pfirodé je tedy vhodné a dle mého nazoru na misté, aby bylo
pouzivano tzv. pfirodé blizkych opatfeni jako jsou kamenné zahozy apod. To
pfrirodu poSkozuje méné, nez napf. pomoci tzv. technickych opatfeni jako jsou vodni

kapitole 6.2., v zastavéné oblasti.

V souvislosti s uvedenymi opatfenimi je dale nutné polozit si nékteré otazky

jako napf.
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- jaké zavady nam povodriova zména pfinesla

- které aspekty povodriové zmény je nutné fesit technickymi zasahy

- jaké pfinosy nam povodriova zména pfinesla

- jaky je cilovy stav daného vodniho toku

- jaky je mozny — vhodny dalSi postup

- jak provést konkrétni kroky ve formé napravnych opatfeni tak, aby tato opatfeni

byla co nejméné z ekonomického pohledu, nakladna a ucinna

Dale je nutné pfi odstrafovani povodfiovych Skod pfijimat nastinéna opatfeni

ekologicky Setrné, tzn.

- usazeniny odstrafiovat vyhradné ze stfedu koryt a pfi tom Setfit bfehy
(stabilizované prirodni pasaze brehl zbyte€né neposkozovat, nestrhavat jejich
drnovy pokryv a nenicit kofenovy systém dfevin

- pro nezbytnou sanaci nadrzi a vymoll upfednostriovat pfirodé blizké kamenné
zahozy, které |ze pouZzit i pfi zahozech a opravach starych dlazeb

- pokud mozno, nevytvaret v koryté spadové stupné, nejvySe nizké prahy a skluzy

Takovym to otazkam je tedy nutné vénovat pozornost a zvazovat, zda vibec
k nékterym uvedenym protipovodrfiovym opatfenim pfistupovat, protoze i povodné

mohou mit pozitivni ucinky. (¢asopis Ochrany pfirody €. 4/2009 a 6/2010)

6.4. Dasledky uprav na charakter toku

PFfi projektovani uprav vodnich tokl musime stale sledovat vSechny
disledky, které provedena uprava toku vyvola. Technickym zasahem pfi Upravé
toku ovliviiujeme jeho dosavadni pfirozeny charakter, zejména zasahujeme do
rezimu odtoku vody v koryté a stavu hladiny podzemni vody v pfilehlém uzemi.

Samotné upravy tok( provadime pro ruzny ucel, vétSinou pro neskodné

odvedeni vod, k dosaZeni rovnovahy pohybu splavenin, pro ustaleni hladiny

32



podzemni vody z hlediska zemédélskych zajmd, pro mistni ochranu objektd,
obyvatel apod. mnohdy jsou poZadavky na Upravu toku velmi sloZité.

Musime si pfi tom byt védomi toho, Zze upravou koryta zrychlujeme odtok
vody, i pfi ponechani puvodniho sklonu dna, nebot vyrovnanim a opevnénim svaha
bfehu sniZzujeme jeho mnohdy drsnost. Urychleni odtoku jesté vétsi mérou ovlivni
nepfiznivé zvétSovani sklonu dna zkracovanim délky toku, zejména znaCnym
napfimovanim trasy a odfezavanim vétSich zakrutl. Musime mit tedy na zfeteli
kapacitu koryta v dolni Casti useku, zejména pfi mistni upravé toku, abychom
nezhorsili pritokové poméry. Dostate¢nou kapacitu koryta v dolni ¢asti toku mize
zabezpedit soustavna Uprava toku, provadéna postupné od vyusténi proti toku.

Musime si byt védomi dale toho, Ze Upravou toku v hrazich soustfedujeme
pritok do ohrazovaného koryta a zrychlujeme odtok vétSich vod vyloucenim
dosavadnich inundacnich prostord. Tim se zbavujeme mnohdy vitané zaplavy
prilehlych pobfezi pozemk( okalovymi vodami.

Pfi projektovani Upravy toku je rovnéz nezbytné posoudit vliv Upravy na
rezim splavenin. ZmenSovanim sklonu nové navrzené nivelety dna v kratkém useku
toku muizeme zplsobit nezadouci regresivni erozi koryta v horni trati nad
upravovanym usekem.

Upravou toku a zménou vy$ek hladin proti pdvodnimu stavu v koryté
zasahujeme mnohdy nepfiznivé do urovné hladiny podzemni vody v pfilehlém
uzemi. Nepfiznivym zafiznutim koryta a sniZzenim urovné hladiny v koryté, zejména
hladiny nejCastéjSich pratoku, snizujeme stavy podzemni vody a naopak zvySenim
vodnich stav( v koryté vyvolavame opét zvySeni hladiny podzemni vody v okoli
toku. Zmény darovné hladiny podzemni vody =zasahuji nepfiznivé nejen
v zemédélstvi, ale zhorSuji podminky vyuzZiti vody pro ucely zasobovani.
K posouzeni optimalni urovné hladiny podzemni vody musime provést pfedem
peclivy prazkum pfilehlého Uzemi, musime se dokonale seznamit s poméry
hydrologickymi, s charakteristikou pfirozeného toku a vSemi vodohospodaFskymi
podminkami v povodi toku. Pfi samotném navrhu pak musime uvaZzit ekonomické
podminky kraje i jeho vyhledovy rozvoj a vystavbu.

Technicky zasah do krajiny nesmi pusobit tvrdé, ale ma do ni citlivé zapadat.
Zpusoby uprav maji byt voleny tak, aby odstrafiovaly zavady vodnich toku
Vv neupraveném stavu, aniz by vSak porusily jejich pfirozeny raz, zvlasté nasilnymi
zménami v smérové trase, volbou nevhodnych zpusobl opevnéni bfehl koryt,
neodlvodnénou likvidaci esteticky plsobivych bfehovych porostl atd.

Vyznam a prospésnost Uprav vodnich tokl je tfeba hodnotit z hlediska jejich

krajinotvorné funkce. Toky jsou integralni soucasti pfirodniho prostfedi, proto pfi
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navrhu jejich uprav musi byt pfihlédnuto nejen k hlediskim stavebné — technickym a
ekonomickym, ale ma byt sou€asné posuzovana biologicka rovnovaha krajiny. Tok
je tfeba upravit tak, aby se stal organickou soucasti pfirody. Pfi tom by mél byt
zachovan puvodni raz krajiny a nedostatky odstranény.

Jen podrobna znalost mistnich podminek s vyuzitim teoretickych znalosti o
upravach vodnich tokd, doplnénych praktickymi zkuSenostmi, mize poskytnout
ucelné feSeni upravy, které pfinese prospéch danému regionu, potazmo celé

spoleCnosti. (Kovar, 1988)
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7. MATEMATICKE MODELY V HYDROLOGII

PFi vypocitavani rlznych vlastnosti vodnich tok( pouzivame v hydrologii
celou fadu modell. Jedna se napf. o matematické modelovani, fyzikalni
modelovani atd. V dané kapitole bych rad uved! ty matematické a to z diivodu, ze
budeme v nasledujicich kapitolach pracovat s programem Hec — Ras, coz je
software  pro uréeny pro matematické modelovani  fiénich  tok

v jednodimenzionalnim pohledu (1D).

7.1 Matematické modelovani

Pfi matematickém modelovani pfirozenych i umélych otevienych koryt je
tfeba postupovat metodicky stejné jako pfi experimentalnim vyzkumu na
hydraulickych modelech. To znamena, Zze kazdy matematicky model je Zadouci vzdy
verifikovat. To vyzaduje zpravidla opakovanou uUpravu nékterych dat (soucinitel(l
drsnosti, neefektivnich pratocnych ploch atd.) tak, aby se dosahlo pozadované
shody simulovanych parametri (pribéhd hladin) s parametry zaméfenymi. V
opacném pfipadé mohou mit vysledky vypoctl - i pfi znanych zkuSenostech -

pouze kvalitativni charakter, a to bez ohledu na druh pouzitého modelu.

7.1.1. Matematické modelovani 1D

Matematické modely 1D se pouzivaji pro vySetfovani pradbéht hladin v
podélném profilu vodniho toku pfi povodnich riizné Cetnosti vyskytu. V pfipadé, ze
posuzovany usek vodniho toku protéka Clenitym nebo zastavénym inundacnim
uzemim, vyzaduje tvorba modelu velké zkuSenosti, jelikoZ je nutno provadét tzv.

vétveni toku, kde dochazi k pfeduréeni sméru proudéni.

V 1D modelech je prostiedi obvykle definovano geometrickymi a
hydraulickymi parametry vhodné zvoleného souboru pfi¢nych profild toku. Samotné
proudéni je pfitom popsano stfednimi hodnotami veli€in v téchto profilech (hloubka,
rychlost, pratok). Pomoci 1D matematickych modelu Ize Fesit jak pfipady ustaleného
proudéni, kdy je pratok v ¢ase konstantni, tak i pfipady neustaleného proudéni za

realnych povodnovych situaci.
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obr. &. 6 Schéma 1D matematického modelu Useku fi¢niho toku

Zakladni vstupni udaje pro 1D matematické modelovani Fi¢nich useku tvofi:
- zamértené pfi¢né profily modelovaného Useku toku. Jejich umisténi je tfeba volit
tak, aby mezi dvémi sousednimi profily bylo mozno pfedpokladat linearni prabéh

geometrickych a hydraulickych parametru

- navrhovy prutok a kontrolni navrhovy pruatok, popf. hydrogram n-leté povodné v

posuzované lokalité (horni okrajova podminka fesenti)

- vhodna dolni okrajova podminka (napf. znama hladina, sklon hladiny, kriticka
hloubka)

- drsnosti koryta toku a jejich rozdéleni v pficném profilu

- definovani pritocnych a neprutocnych oblasti v pfiéném profilu toku

1D matematicky model je schopen podat informace o podélném sklonu

hladiny v posuzovaném useku vodniho toku, o udrovni hladin v jednotlivych

zaméfenych pfi€énych profilech, o prostorovém rozlivu v posuzované lokalité a
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primérné rychlosti proudéni v zaméfenych pFicnych profilech véetné mostniho
profilu. Nékteré 1D matematické modely jsou schopny pomoci prouzkové metody
poskytnout udaje o rozdéleni rychlosti proudéni v pficném profilu. Tyto vysledky je
mozné pouzit pouze v pfimych nebo prismatickych Usecich tokl, kde prevliada
podélna slozka proudéni, nikoliv vS8ak v meandrujicich korytech nebo v Sirokém
inundacnim uzemi. Nékteré 1D modely jsou schopny zjednoduSsenym zplsobem na
zakladé ubytku prato¢né plochy v mostni otvoru feSit i ucpavani mostniho profilu

splavim.

Pro 1D matematické modelovani fi¢nich tokl Ize pouzit napf. tyto softwarové

prostredky:

- software HYDROCHECK 3 - umoznuje simulovat hydraulicky rezim
v libovolné rozvétveném systému otevienych neprizmatickych koryt obecného tvaru
priénych profild, s vodnimi dily nebo objekty situovanymi na hlavnim toku i na
kterékoliv vétvi pFitokl. Systém otevienych koryt mize obsahovat i soustfedéné

pritoky a odbéry, resp. dalsi singularity.

- software MIKE 11 - matematicky model modularni stavby, umoziujici
simulovat neustalené proudéni v siti otevienych koryt libovolného tvaru pfiéného
prafezu, vCetné objektd zakladniho typu. Na zakladni hydrodynamicky modul
navazuje fada dalSich modull, mezi nimi modul ,Non-Cohesive Sediment Transport
and Morphological [NST] Module" simulujici morfologické zmény koryta (vymilani,

zanas$eni).

- software HEC-RAS, River Analysis System - je schopen feSit ustalené a
neustalené proudéni v otevienych korytech s oboustrannym inundacnim uzemim,
vCetné rozdéleni rychlosti a pritokd v pficném profilu pfi konstantni hladiné v
pficném profilu. Stupen drsnosti Ize zadavat pomoci Manningova drsnostniho
soucinitele nebo pomoci ekvivalentni drsnosti K. Kromé zakladnich hydraulickych
modull pro ustalené a obsahuje modul pro simulaci transportu sedimentt v koryté
toku, kvalitativni teplotni modul, modul pro projektovani uprav koryt, mozZnost
manipulace na jezovych objektech a graficky editor. Model dale umozfuje export dat
do programu typu GIS nebo CAD. Vyhodou tohoto modelu je propracované reSeni
mostnich objektd, propustkl a jezl, v€etné moznosti vypoctu proudéni pres
pfelévanou mostovku. BliZze viz kapitola 8.1. (Hydrotechnické posouzeni mostnich
objektu na vodnich tocich, 2009)
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7.1.2. Matematické modelovani 2D

Matematické modelovani 2D se pouziva pro hydraulické feSeni mostnich
objektd v pripadech, kdy 1D modelovani jiz nema dostateCnou vypovidaci
schopnost. Pfichazi to v uvahu u mostnich objektl s vysokou dopravni dulezitosti,
kfizujicich meandrujici a morfologicky slozité vodni toky resp. vodni toky s pfilehlym
Sirokym a Clenitym inundac¢nim uzemim. Pomoci 2D matematickych modell Ize
pomeérné hodnovérné vysetfit proudové poméry (pribéh proudnic, vektory stfednich
svislicovych rychlosti proudéni) v plochém i rizné ¢lenitém inunda¢nim uzemi, vliv
jednotlivych pfekazek na okolni proudové pole, hydrodynamické uc&inky proudici

vody na mostni podpéry apod.

[mnam]

obr. &. 7 Mapa rychlosti proudéni (a) a urovni hladiny (b) pomoci 2D modelu

Matematicky popis modelovaného jevu - proudéni vody, pohybu splavenin -
vede k soustavé parcialnich diferencialnich rovnic, pro jejiz numerické feSeni se
nejCastéji pouziva metoda koneénych diferenci, metoda kone¢nych objemu nebo
metoda koneénych prvkl. Pfesnost vysledkl je dana predevSim presnosti vstupnich
podkladli, ale hodné zavisi i na vhodné volbé sité uzlovych bodl a jeji hustoté. Z

toho Casto vyplyvaji problémy, zpisobené naroky na pamét pocitace a jeho vykon.
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Vv,

jejich pouziti je proto nakladnéjsi - oproti 1D modelim vice nez dvojnasobné.

Pomoci 2D matematickych model( Ize feSit - obdobné jako u 1D modeld, jak
pfipady ustaleného proudéni, kdy pratok v Case je konstantni, tak i pripady

neustaleného proudéni za realnych povodnovych situaci.

Zakladni vstupni udaje pro 2D matematické modelovani fi¢nich Useku tvofi:

- podrobné tachymetrické zaméfeni modelovaného useku toku a pfilehlého

inundac¢niho uzemi, které je podkladem pro tvorbu trojrozmérného modelu terénu

- navrhovy pritok a kontrolni navrhovy prutok, popf. hydrogram n-leté povodné v

posuzované lokalité

- okrajové podminky feSeni v obou okrajovych profilech modelovaného useku
vodniho toku. Lze je zadavat i rGznym rozdélenim prutokd nebo rychlosti proudéni

podél okrajového profilu

- drsnosti koryta toku a inunda¢niho uzemi, jejich zmény v podélném a pficném

sméru

- granulometrie dnového materialu (v pfipadé modelovani morfologickych zmén

koryta toku)

Pro 2D matematické modelovani fiénich tok(l se dnes pouzivaji softwarové

prostfedky, vyvinuté u nas nebo ziskané ze zahranici. Z nich Ize uvést napf.:

- software SHALLOW - 2D model umoZzhujici simulovat ustalené proudéni i
v oblastech s pfitoky a odbéry. Pro popis geometrie zkoumané oblasti a pro feSeni
ustaleného proudéni pouziva izoparametrické kvadratické koneCné prvky s osmi
uzly a s moznosti zakfiveni stran. Vypocetni sit muze byt zcela libovolna, Ize ji
lokalné zahustovat a pfizpGsobovat slozité geometrii prostfedi (objekty, pfekazky
apod.). V jednotlivych kone€nych prvcich Ize zadavat rGizné drsnosti dna. Model je
vybaven systémem grafickych interaktivnich pre- a post- procesorli, koncipovanych

jako aplikace ADS pro graficky systém AutoCAD. Lze jej vyhodné pouzit pro
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vySetfovani proudovych pomérd, rychlosti proudéni a prostorovych deformaci hladin

pfi kulminacnich povodriovych pratocich v slozZitém prostredi.

- software FAST 2D - model zaloZeny na metodé konecnych objemu, kde
neznamé jsou definovany ve stfedech konecnych objema, pfi€emz obsahuje i k-€
model turbulence. Pro znazornéni modelované oblasti pouziva strukturovanou
nez sit ortogonalni. Model umozniuje feSit ustalené i neustalené proudéni v
morfologicky slozitych ficnich tratich a pfilehlych inundacnich Gzemich s rozli¢nou
zastavbou. Model ma obdobné vybaveni jako pfedchazejici a umoznuje tedy ziskat
vSechny potfebné udaje o proudovych pomérech, rychlostnich polich a prostorovych

deformacich hladin.

- software FLUVIUS - 2D model umoznujici simulovat ustalené i neustalené
proudéni vody v fi€nich korytech a inundacnich Uzemich. Model pouziva
vystfidanou ortogonaini sit' s ekvidistantnim krokem. V ramci modelované oblasti Ize
simulovat nepfelitelné prekazky, reprezentujici zastavbu, hraze, mostni objekty
apod., jakoz i proménnost dnovych odporu. Soucasti simulace je zaplavovani a
opétné obnazovani inundacnich uzemi. Jeho vyhodou je vazba na systémy GIS
(napf. geodeticky software ATLAS) s moznosti importu vrstevnicovych map a
naslednou automatizovanou tvorbou vstupnich geometrickych dat. Kvalitné je
zpracovan i vystupni, graficky orientovany modul, dovolujici prezentaci vysledku

fadou rdznych forem, v€éetné animace

- software MIKE 21 - 2D programovy prostfedek umozniujici feSit Siroké
spektrum problém0 ficni hydrauliky. Zakladni hydrodynamicky modul FeSi fidici
rovnice metodou konecnych diferenci na ortogonalni siti s ekvidistantnim krokem.
Tento zakladni modul Ize doplnit o Sediment Transport Module a fadu dalSich

modull, v&etné modulu pro simulaci vin

- software SMS (Surface Modelling System) - je urCen k modelovani 2D
proudéni s volnou hladinou. Jedna se o komplexni nastroj, ktery umozriuje vytvaret
vypoCetni sité (Mesh modul, Map modul a Scatter modul) a provadét potfebné
vypoCty proudéni pomoci nékterého z modell zalozeného na 2D pfistupu vcetné
prezentace vysledkl. Soucasti SMS jsou matematické modely FeSici 2D proudéni s

volnou hladinou (modely RMA2 a FESWMS), dvourozmérny pohyb vody pfi velmi
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vysokych rychlostech proudéni (model HIVEL2D), dvourozmérny pohyb splavenin
(model SED2) a dvourozmérné $ifeni znedisténi (RMA4). Reseni vSech modeld je

zaloZeno na metodé konecnych prvka.

- software FESWMS (Finite Element Surface-Water Modeling System) - 2D
model umozniujici fesit ustalené i neustalené proudéni, a to jak v oblasti ficniho, tak
i bystfinného rezimu. Velkou prednosti modelu je moznost simulovani dulezitych
objektl na toku, jako jsou jezy a mosty, v€etné vypoctu tlakového proudéni.

(Hydrotechnické posouzeni mostnich objektl na vodnich tocich, 2009)

7.1.3. Matematické modelovani 3D

Pro vySetfovani prostorového proudéni v lokalitach tvarové slozitého
prostiedi lze vyuzZivat metodu 3D matematického modelovani. 3D matematické
modely jsou vhodné pro simulaci obtékani stfedovych a bfehovych podpér mostnich
objektl a propustkd v pfipadech, kdy je nutno vySetfit, zda dojde nebo nedojde k
prekro€eni vymilacich rychlosti a kdy je popf. potfebné navrhnout vhodna opatfeni

ve formé opevnéni dna a biehu koryta.

V soucasnosti se k 3D matematickému modelovani proudéni pouziva napf.:

- software COMSOL Multiphysics (dfive FEMLAB) - v tomto prostfedi Ize
vyuzit k-¢ turbulentniho modelu v 3D schematizaci, v némz je pro numerickou
aproximaci fidicich rovnic pouzita metoda kone¢nych prvk(. Jeho pouziti pro
modelovani proudéni na dlouhych a slozitych Fficnich usecich v8ak narazi na

omezeni rychlosti sou¢asnych pocitacl a velikosti jejich operaéni paméti.

Vzhledem k uvedenému hardwarovému omezeni se pfi modelovani delSich
ficnich usekl obvykle pouziva kombinace 2D a 3D schematizace. V prvni fazi se na
2D modelu vySetfi rychlostni pole s rozdélenim svislicovych rychlosti v profilu pfed
lokalitou mostniho objektu. Toto rychlostni pole v druhé fazi slouzi jako vstupni
okrajova podminka pro 3D model, na némz je potom zkoumano prostorové proudéni
ve vlastni lokalité. (Hydrotechnické posouzeni mostnich objektd na vodnich tocich,
2009)
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8. HYDROTECHNICKE POSOUZENi VYBRANEHO USEKU
JANOVICKEHO POTOKA

8.1. Software HEC-RAS

Samotny Program HEC RAS byl vyvinut U.S. Army Corps for Engineers,
Hydrologic Engineering Center, River Analysis System. Oproti pfedchozim verzim
zahrnuje i vypocCty v rezimu neustaleného proudéni a mnoho novych prvkl v rezimu
ustaleného proudéni. Dale umoziiuje prostfednictvim nadstavby HEC-GeoRas
importovat geometricka data pomoci ArcView GIS do HEC-RAS a vysledky vypocta
zpétné exportovat do prostiedi GIS. Rovnéz se vyraznym zpusobem zvysil

uzivatelsky komfort a graficka i tabelarni prezentace vysledku.
8.2. Manual a instalace programu

Nez pfejdeme k samotné manipulaci s programem Hec - Ras je nutné si
pfipravit potfebna data pro, v nasem pfipadé, vypocCet zaplavového uzemi na

vybraném useku Janovického potoka.

Vzhledem k tomu, Ze program Hec — Ras je freeware, Ize jej poridit zcela

bez problém(. V naSem pfipadé budeme pracovat s verzi 4.0.

Po samotném nainstalovani programu Hec — Ras, verze 4.0 se na ploSe
R&S
pocitaCe vytvofila, pokud jsme provedli vytvofeni ikony l}ltil_ pomoci které se

program velmi snadno spousti.
8.3. Samotné spusténi a nastaveni software HEC-RAS
Vzhledem ktomu, Ze se jedna program vyvinuty U.S. Army Corps for

Engineers tak tento neni pfizpusoben pro Evropské pouzivani. Proto po samotné

instalaci je nutné provést zménu Narodniho prostfedi v nasledujicim formatu.
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Obecné: Angli¢tina (Spojené staty)
Cas: h:mm:ss tt

Datum: kratky format MM/dd/rr
Oddélovac /

Dlouhy format 24 July,2001

Dd MMMM, rrrr

Dale musime provést zménu z americkych jednotek na metricky systém SI.

To se provede po spusténi programu v zakladni nabidce Options => Unit system.

V neposledni fadé plati nepsané pravidlo, Zze program Hec — Ras neumi

pracovat s ¢arkou, a proto se standardné pouZziva misto ¢arky tecka.
8.4. Zadani potrebnych dat do programu

Po spusténi a nastaveni potfebnych parametri se jako prvni krok vytvofi
novy projekt a to pomoci File => New projekt, kde nasledné zadame i nazev
projektu. Po zadani nazvu se nam novy projekt ulozi do nami zvoleného kmenového
adresare na pevném disku s koncovkou .prj.

Po vytvofeni nového projektu zaCiname vkladat potfebna data, v naSem

pfipadé pro vypocet zaplavového uzemi na Janovickém potoce.

V zakladnim menu klikneme na ikonu Igl Edit/Enter geomatric data. Po

otevieni nového okna pomoci ikony @ Add/Edit background Picture fot the
schematic provedeme zkopirovani mapy zajmového Uzemi do programu, coz se
provede pfikazem Add a potvrdi se Ok. Tim dojde ke zkopirovani mapy zajmoveého

uzemi do programu.

River

Reach
e

Poté pomoci ikony Add a new river reach to the schematic a tuzky
provedeme obkresleni zajmové uzemi podle zkopirované mapy.

Nyni zaddme naméfena data pficnych profild spoleéné s vyznacenim
nadmoiské vysky, stanoveni stanic¢nich kilometrd jednotlivych pfi€nych profild
S namérenou vzdalenosti mezi jednotlivymi profily.

Zadani nové pficného profilu do programu Hec — Ras se provede pomoci

Cross
Section

ikony

Edit and/or create Gross sections, ¢imz dojde k otevieni nového okna
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s Cross Section data. Pomoci ikony v Zakladnim menu Options => Add a new Cross
sections ..., dojde k vytvofeni nového pfiéného profilu, kdy jako nazev nového
profilu uvedeme F. km. Postupné zadame naméreni hodnoty pfiénych profila, kdy
po zadani potfebnych informaci pomoci ikony v zakladnim menu Plot =>Plot
cross sections ... dojde ke grafickému znazornéni nami zadanych dat, s pfesnym
vymezenim levého a pravého bfehu. Zarovefi se nam zadany pficny profil znazorni

na vykreslené mapé.

Soucasti samotnych dat potfebnych pro zadani pfiéného profilu je dale
stanoveni pfesné vzdalenosti od pfedchoziho pficného profilu a zadani soudinitele
drsnosti, coz jsme v nasem pfipadé vyreSili koeficientem 0,03 a to z duvodu
struktury dna vodniho toku po celé délce vybrané ¢asti. Dale stanoveni délky od

vychoziho bodu méfeni s uréenim nadmorske vysky.

o 4o o 0] 9]t G |
=14/ rmr————

PR F 2 5 55 = 5

obr. & 8 Grafické znazornéni pficného profilu s vymezenim levého a pravého bfehu spole¢né se

zadanymi hodnotami

Timto zpusobem zadame do programu vSechny pfi¢né profily.
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obr. &. 10 Zadané pri¢né profily znazornéné bez podkladové turistické mapy

V této fazi projektu zadame do programu objekty (v naSem pfipadé se jedna

o dva silniéni mosty a jednu Zelezobetonovou lavku), coz se provede pomoci ikony
Brdg,/Cul.
= Edit and/or create bridges and culvert. Dojde k otevieni nového okna, kdy

pomoci polozky v Zakladnim menu Options => Add a Bridge/and or Culvert ...,

dojde po zadani F. km. k vytvoieni nového objektu na vodnim toku.
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Deck,
Roadway

Po zadani f.km pomoci ikony Deck/Roudway Data Editor dojde
k otevieni nového okna, kde zadame hodnoty objektu. K kolonce Distance uvedeme
vzdalenost objektu od predchoziho nejbliz§iho pfi€ného profilu. V kolonce Widh
zadame celkovou Sifi objektu. Nasledné k kolonce Upstream zadame potfebné
hodnoty objektu, coz jsou maximalni a minimalni nadmoiské vySky a rozmérovou
hodnotu objektu. Poté tyto hodnoty pomoci Copy US to DS zkopirujeme do tabulky
Downstream. Ostatni hodnoty zlstanou zachovany. Pak provedeme kliknuti na OK

a tim dojde k zakresleni nami zadaného objektu mezi pfi¢né profily, podle .km.

e Cotrt Dt - Brchypetek.
" o

obr. . 11 Vysledné zobrazeni zadaného objektu (silniéniho mostu) do programu Hec — Ras
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obr. €. 12 Zobrazeny zadany objekt mezi pfic¢nymi profily

Timto zplsobem do programu zadame vSechny objekty, nachazejici se

v nadem zgjmovém uzemi.
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obr. ¢. 13 Vysledné zobrazeni po zadani vSech pfi¢nych profili a objektl na vybraném useku

Janovického potoka na podkladové mapé

Jako posledni do programu zadame N-leté pritoky, coz se provede
otevienim nového okna v Zakladnim menu Hec - Ras pomoci Edit => Steady Flow
Data. Po otevieni nového okna jako prvni data zadame do kolonky Entre/Edit
Numer of Profiles pocet N-letych pratok(. Pomoci menu Options => Edit Profil

names ... zadame jednotlivé nazvy N-letych prutokd. Do pfipravenych kolonek pak
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zadame jednotlivé N-leté pritoky. V neposledni fadé zadame do kolonky River Sta.:
stani¢ni kilometr uvedenych N-letych pratokd. Jako posledni data potfebna pro
kompletaci N-letych pratokd klikneme na ikonu Reach Boundary Conditions, kde
zadame namérenou hodnotu pratoku (v nasem pfipadé Q1, Q2, Q5, Q10, Q20, Q50
a Q100).

Po zadani vSech potfebnych dat do programu Hec — Ras provedeme pomoci

ikony g Perform a Steady flow simulation a kliknuti na tlacitko COMPUTE
vypocCet ndami zadanych hodnot. Po provedeni vypoctu si projekt uloZime.

Hecnse a'® @]
ie E

18] e el LA = A e el ek
Pt [eopi: ar] =]

obr. €. 14 Znazornéni ulozeného projektu pfed zadanim vypoctu
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8.5. Vysledky

Po celkovych vypoctech nam nové okno HEC — RAS Finished Computations

znazorni vysledky nami zadanych hodnot.

e Bt Ran e

—
ECIERSR RS SR R RGN
Pt feneuiipon — o

Seins | __odd 1 W1 nazeom £1 A1 oo
T W

obr. €. 15 Potvrzujici okno po celkovych vypoctech
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9. CELKOVE VYSLEDKY

Program HEC — RAS nam nabizi velmi Siroké moznosti prohlizeni a samotné
prezentace vysledku a to jak tabulkovych, tak i grafickych.

Cilem této Diplomoveé prace bylo hydrotechnické posouzeni Uprav na vodnim
toku Janovicky potok v k.U. obce Vaclavice, kdy pomoci zadanych dat do programu
HEC — RAS bylo vypocitano zaplavové uzemi pro az 100letou vodu. Na obr. ¢. 16
aZ obr. 19 je v grafické podobé znazornéno (modrou barvou) zaplavové Uzemi pro
hladinu Q1, Q10, Q 50 a Q 100 v zastavéném uzemi obce Vaclavice, které se
nachazi od f.km 7,5 az ¥.km 6,7.

Ve zbylém useku, do vzdalenosti 200 m od ficniho koryta Janovického

potoka, se kromé uvedeného mostu na f.km 8,308 jiné objekty nenachazi.

aaaaa

obr. €. 16 Vypocitana hladina Q 1 se znazornénim zaplavového tUzemi
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Janowiclypotok  Plan: Janovicky potok 4/24/2011
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obr. &. 17 Vypocitana hladina Q 10 se znazornénim zaplavového uzemi

Janowickypotok Plan: Janovicky potok 4/24/2011
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obr. €. 18 Vypocitana hladina Q 50 se znazornénim zaplavového tzemi

Janowickypotok  Plan: Janovicky potok  4/24/2011
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obr. &. 19 Vypocitana hladina Q 100 se znazornénim zaplavového uzemi
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Z téchto vysledku vyplyva skutecnost, ktera byla v praxi nékolikrat potvrzena
ato je, ze v pfipadé hladiny Q1 se voda v podstaté nikam nerozléva a s pfibyvanim
pratocnosti vody az do hladiny Q100 se voda rozléva na zemédélsky
obhospodafovana uzemi, nachazejici se na obou koncich obce, tedy v okoli F.km
7,5 — 7,2 v pfipadé jednoho konce zastavéného uzemi a v pfipadé druhého konce
zastavéného uzemi se jedna o usek f.km 6,8 — 6,0.

Samostatné znazornéni objektl na ficnim toku Janovické potoka, tedy dvou
silniénich mostt a jedné Zelezobetonové lavky s jednotlivymi N-letymi pratoky je
znazornéno v grafické podobé v pfilohach.

Nastinéni zaplavového Uzemi pro Q1, Q10, Q 50 a Q 100 v celém uUseku
Janovického potoka je pak také soucasti pfiloh.

DalSim moznym vystupem bylo znazornéni pfi¢ného profilu s jednotlivymi N-
letymi pratoky. Na obr. ¢. 20 je znazornén pri¢ny profil na f.km 9,245 s hladinou
Q1,Q2, Q5, Q10, Q20, Q50 a Q100. Timto zplsobem to bylo vypracovano pro
kazdy pfi¢ny profil.

]
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obr. &. 20 Znazornéni hladin pficného profilu 9,245 ¥.km. s jednotlivymi N-letymi pratoky

Podrobnéjsi grafické znazornéni vyhodnocenych vysledkl je taktéz soucasti

pfiloh této Diplomové prace.
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10. MOZNY NAVRH

Stanovenim zaplavového uzemi pomoci programu HEC - RAS byla
potvrzena ta skute¢nost, Ze v pfipadé povodni je z celého nami vybraného useku
ohrozen pouze Usek od F.km 7,2 az fkm 6,8 a to z dlvodu, Zze se zde nachazi
vétSina objektd uvedenych v kapitole 5.5.1. Ostatni useky jsou pfi hladiné Q100 také
postizeny, ale vzhledem k tomu, Ze se zde nenachazi zadna zastavéna uzemi,
nemélo by vyznam zde provadét néjaka protipovodriova opatfeni.

PFi navrhu protipovodriovych opatfeni je nutné dbat na to, aby pfi jakémkoliv

zasahu byl, pokud mozno, co nejméné naruSen krajinny raz okoli toku.
Moznym FeSenim rizik vzniklych pfi zaplavach by se dalo predejit napf. revitalizaci
useku, protékajiciho obci nebo vycisténim retenéni nadrze, ktera se zde nachazi,
avSak u samotné retencni nadrze by bylo zapotfebi provést celkovou obnovu,
protoze za soucCasné situace to vypada jako by zde retenéni nadrz vibec nebyla.
V minulosti obec Vaclavice dokonce zadala na povodi Vitavy, statni podnik, zavod
Dolni Vitava o revitalizaci ficniho toku, avSak tento navrh nebyl nikdy realizovan.
K tomuto bylo dale zjisténo, Ze byl na uvedené povodi podan ve spolupraci s
Agenturou Praha — ochrana pfirody a obci Vaclavice novy navrh spatfovan
v revitalizaci Janovického potoka v useku F.km 7 az F.km 6, tedy v zastavéném
uzemi obce Vaclavice, ale ten je v sou¢asné dobé v pfipravné fazi.

Z hlediska moznych uprav by se v zajmovém uzemi (f.km 7,2 az 6,8 f.km)
dalo uvazovat 0 mozném zpevnéni vybraného Useku pomoci napf. vodniho skluzu,
ktery by byl vybudovan nad hranici Q 100. Jedna se o pfiblizné 400 metrovy usek,
kde by v8ak pfed samotnym technickym zasahem, jak jiZz bylo nastinéno, mélo dojit
k vycisténi Ficniho koryta, fecCisté a okoli bfeh(, které jsou po vétSinu roku zarostlé
vegetaci. Tato vegetace navic tim, Ze se neudrzuje a zadnym zpusobem nekultivuje
kazdoroCné zuzuje Sifi a tim zmenSuje vodni koryta, coz ma za nasledek mensi
pruto¢nost vody a tim padem vétsi riziko pfi povodnich. Po provedeni zminéného
vycCisténi by se teprve mohl vybudovat vodni skluz. Samotny vodni skluz by byl
dlouhy, tak jak jiz bylo uvedeno pfiblizné 400 m. U tohoto technického feSeni by bylo
vhodné, aby tento vodni skluz byl projektovan v minimalni vysi hladiny = Q100 a
vétSi. Nastinéné protipovodinové feSeni by bylo mozné jesSté doplnit vysadbou
vhodnych dfevin na hornich bfezich nebo v blizkém okoli bfeht po celé délce
vodniho skluzu.

Pfipadnym dal§im mozZnym protipovodriovym opatfenim by bylo zpevnéni
obou bfehl na f.km 7,2 az f.km 6,8 pomoci napf. vhodnych dfevin, kamen( nebo

betonovych desek. | vtomto pfipadé je vSak nutné uvést, Ze pfed samotnym
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zamérem by bylo nutné pfistoupit, jak jiz bylo uvedeno k obnové fi¢niho toku.

Jako protipovodiiové opatfeni by ale dle mého nazoru stadilo i to, kdyby se
fecisté vodniho toku vycistilo od naplavenych dfevin apod. a pravidelné se
udrzovalo. S touto upravou by bylo spojeno rozsifeni obou bfehl. Tento se zpUsob
upravy vodniho toku Janovického potoka je navic z ekonomického pohledu ten
nejrealngjsi.

V neposledni fadé by bylo vhodné provést revitalizaci melioraénich pfikopu,
které jsou v souCasné dobé také ve velmi znehodnoceném stavu, a které maji na

hladinu vody pfi povodnich také vliv.
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11. DISKUSE

Nami feSené uzemi se dle rozhodnuti Krajského ufadu StfedoCeskeho kraje,
odboru Zivotniho prostfedi nachazi v zaplavovém uzemi Janovického potoka. Po
zadani potfebnych dat bylo programem HEC — RAS stanoveno zaplavové uzemi, ze
kterého vyplynulo, ze v zastavéné Casti obce Vaclavice dochazi k rozlivu vody pfi
povodnich vzdy ve stejnych mistech a zpravidla dochazi ke stejnym potazmo
obdobnym Skodam na majetku. A tak je v daném pfipadé zapotfebi polozit si
otazku, zda by mélo vyznam budovat, ve vétSiné pfipadl z ekonomického pohledu
nakladné protipovodnové opatieni, kdyz pfi nejhorSich zaplavach v novodobé
historii obce Vaclavice v roce 2006 vznikly minimalni materialni Skody.

Problematika povodni v nami feSeném useku nebyla do sou¢asné doby vice
méné feSena vibec. Proto jsem v ramci zpracovani této Diplomové prace navstivil

starostu obce Vaclavice, p. Zderika Votrubu.

11.1. Slovo starosty obce

Z provedené vzajemné konzultace na zpracovavanou problematiku s panem
starostou obce Vaclavic Zderikem Votrubou bylo zjisténo, Ze z historického hlediska
byl prvni vétsi zasah do Janovického potoka proveden kolem r. 1970, kdy byla
provedena Vodohospodarskou spravou meliorace fi¢niho koryta mezi f.km 9 az
f.km 7. AvSak od té doby se Ficni koryto v k.U. obce Zzadnym zplsobem neudrzuje, a
proto se fecisté v sou€asné dobé nachazi ve velmi zanedbaném stavu.

V naslednych letech se pfed obci, na f.km 7,5 vybudovali melioraéni pfikopy
a to jako protipovodriova opatfeni pfi pfivalovych destich. Pfi samotném budovani
vSak byly s vystavbou melioracnich pfikopu v dané lokalité problémy z hlediska
spadu. To se podafilo vyreSit celkové dvéma spady, pficemZ jeden se nachazi
v tésné blizkosti jedné z nemovitosti, ktera je timto kazdoroCné vystavovana

moznym zaplavam.
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obr. €. 21 Znazornéni meliorac¢nich pfikopl se spadem do Janovického p.

(modra barva — tok Janovického potoka, Zluta barva — spady do Janovického potoka

a hnéda barva — melioracni pfikopy)

DalSim vyznamnym problémem z hlediska povodni jsou mozné prlusaky
podzemnich vod. To je vsouCasné dobé také jeden zvelkych nefeSitelnych
problému blizkého okoli Janovického potoka. Na druhou stranu samotné prisaky se
vétSinou vyskytuji v menSim méfitku nez lokalni zaplavy a ve vétSiné pfipadech
dojde k prosaknuti podzemni vody na menS$i zatravnéné plochy jako napf. louky
nebo zahrady apod.

V souCasné dobé se zda byt v dané lokalité jesté jeden problém, a tim je
zejména v jarnich a letnich obdobich rist vegetace v blizkém okoli fecCisté, coz ma
za nasledek zmenSovani Sife koryta a tim padem mensiho pratoku vody. V ramci
jednani zastupitelstva pak byl pfijat navrh jednoho 2z mistnich ob¢anu, ktery

vzniklou situaci bude fesit pravidelnou udrzbou.
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obr. &. 22 Znazornéni vzrostlé vegetace v obdobi letnich mésicl
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12. ZAVER

Cilem této Diplomové prace bylo nastinit problematiku povodni, detailné
popsat zajmové uzemi Janovického potoka a popsat z technického pohledu mozné
upravy vodnich tokd. V zajmovém Uzemi poté pomoci softwaru HEC — RAS stanovit
zaplavové uzemi, nachazejici se k.u. obce Vaclavice.

DalSim cilem této diplomové prace po samotném vypoctu 100-leté vody
(Q100) zjistit, zda jsou ohrozeny stavby v blizkém okoli toku a zhodnotit, zda jsou
tyto stavby vyhovujici, popf. zda jsou tyto stavby néjakym zplsobem ohrozZeny.

Z celkového pohledu znamych vypocCtl je uvodem nutné konstatovat, ze pfi
vypoctu hladiny Q100 nedojde k pFelivu vody pfes jak silni¢ni most nachazejici se
na f.km. 8,308, tak ani pfes most nachazejici se ve stfedu obce Vaclavic, na f.km
7,029. Z tohoto pohledu je vyhovuijici i Zzelezobetonova lavka nachazejici se F.km
6,904. Z grafického pohledu, ktery je soucasti pfiloho této Diplomové prace je pak
patrné, Ze nejblize se voda pfi hladiné Q100 ke konstrukci mostu dostane na f.km
8,308 a to na uroven 40 cm od spodni konstrukce mostu. Naopak most na f.km
7,029 je z hlediska konstrukce jesté l1épe konstruovan, kdy pfi stejné hladiné bude
hladina vody od spodni konstrukce mostu ve vzdalenosti 70 cm.

Z hlediska ohrozenosti objektl nachazejici se v mistech blizkych Fi€nimu
toku Janovického potoka v useku od F.km 7,5 az po F.km 6,8 bylo zjiSténo, Ze
objektu je pfi pratoku hladiny Q100 pfimo ohrozeno hned nékolik. Na druhou stranu
ale bylo potvrzeno to, o ¢em jsme se presvedcili pfi minulych povodnich. A to je to,
Ze ty nejblizSi objekty jsou az na drobné vyjimky zahrady, kde vznikaji majiteldm
mnohdy Zadné popf. zanedbatelné Skody. Z celkem 11 ohroZenych celoro¢né
obydlenych objektd bylo vyhodnocenymi daty zjist€no, Ze se sice nachazeji
v zaplavovém Uuzemi, ale samotné stavby jsou situovany tak, aby v pfipadné
povodni byly dostateCné ochranény, tzn. byly vybudovany dostate¢né nad hladinou
Q100. Navic ke S8kodam na majetku v obydlenych oblastech dochazi sporadicky.
Jeden z objektd nachazejici se na f.km 7,1 je ohrozen i pfi dosazeni hladiny Q 50,
avsak tento je z hlediska konstrukce vybudovan 25 cm nad hladinou 100-leté vody.
O tomto vysledku jsme se navic sami pfesvédcili pfi povodnich v roce 2006, kdy dle
nastinénych fotografii (viz Seznam obrazk( — fotografie ¢. 12 — &. 14.) je patrné, Ze
pratok vody v nami zvoleném uUseku byl srovnatelny s hladinou Q100 a k zadnym
Skodam takika nedoslo.

Z uvedeného vyplynulo, Zze na celém nami vybraném useku Janovického
potoka jsou zaplavova uzemi velmi dobfe situovana bud na neobhospodafované

uzemi, kde se ve vétsiné pfipadl nachazi mnozstvi stromd, kefU a jiné vegetace a
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pokud se vodni tok pfiblizuje k zastavénému uzemi obce Vaclavice, tak jsou zde
vybudovany protipovodfiové plochy — odstavné louky, na kterych se pak nachazi
neudrzovany travni porost.

Zavérem lze shrnout, Ze i kdyZ obec Vaclavice se nachazi v zaplavovém
Uuzemi, tak uz po€atku samotného vzniku obce byla tato budovana mimo zaplavovou
zonu Janovické potoka. Jako mozné feSeni pfedchazeni moznym byt minimalnim
Skodam pfi povodnich by se dalo pfedejit napf. vybudovanim vodniho skluzu apod.,
tak jak bylo uvedeno v kapitole 10.

Dle mého nazoru by vSak postacovala revitalizace vodniho toku v useku,
prochazejici obci Vaclavice spatfovana v prohloubeni a stim spojené vycisténi
ficniho koryta. K tomuto by bylo vhodné provést rozsifeni a zpevnéni obou bfehl. U
tohoto zpusobu je dale nutné konstatovat, Zze z moznych navrhd je ekonomicky
nejméné narocny.

Na druhou stranu je v daném pfipadé na misté polozit si otazku, zda by bylo
nutné vibec néjaka protipovodhova opatfeni pfijmout, kdyz jsme se sami
presvédcili, zejména pfi povodnich v roce 2006, Ze obec Vaclavice je z hlediska

protipovodriovych opatfenich dobfe pfipravena na ,velkou vodu®.

12.1. Mozny dopad vystavby dalnice D3 na stav vodniho toku

Janovického potoka

V zavéru této diplomové prace bych rad nastinil jeSté jeden mozny problém,
ktery muze mit vliv na Janovicky potok a tim je vystavba dalnice D3, v daném
pfipadé se to tyka Zapadni a Vychodni varianty. V pfipadé Janovického potoka je
zasadnéjSi zapadni varianta oproti vychodni, ktera se nachazi od obce Vaclavice ve
vzdalenosti 5 km, na rozdil od zapadni varianty s moznou pfipojkou, ktera se

nachazi 500 metrd od zastavéné &asti obce.
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INVO
4

obr. €. 23 Nastinéni Zapadni varianty dalnice D3

V ramci uvedeného projektu vystavby dalnice D3 byla zpracovana EIA —
posouzeni vlivd na Zivotni prostfedi spole¢nosti Pragoprojekt a.s./Sudop a.s. pro
vychodni smér dalnice D3 a pro zapadni smér dalnice D3.

Proto se vdané kapitole budu vénovat té Zapadni varianté, ktera je
v bezprostfedni blizkosti obce Vaclavice. Ze samostatné dokumentace vyplynulo, Zze
Z hlediska povrchovych vod bude v dobé vystavby dalnice D3 zvySen svod
povrchovych vod do feky Sazavy o 0,03 % z celkového odtoku z povodi za
primérny rok. Samotné odvodnéni ze stavby bude pak feSeno pomoci destové
kanalizace a pomoci otevienych pfikopl v zafezu. Srazkové vody z pfilehlych
povodi pak nebudou zaustény do kanalizace, ale budou zachytavany do silni€nich
pFikopl a odvadény do nejblizSich recipientu.

Z hlediska podzemnich vod bylo zjisténo, Ze v okoli obce Vaclavice by
stavba neméla mit vliv na slozeni podzemni vody. Bylo vSak doporuc¢eno sledovani
hladin ve studnach a provedeni hydrogeologického prazkumu Kk upfesnéni
hydrogeologicke situace.

Pobliz Janovického potoka, ve stanoveném zaplavovém Uzemi obce
Vaclavice bude v pfes nedaleké udoli provedeno pfemosténi 9-polovym mostem,
kdy v samotném zaplavovém uzemi bude celkem 7 mostnich pilifd. Pro navrhovany
most vSak bude nutné provést hydrotechnické posouzeni ovlivnéni hladin pfi

povodnovych pritocich.
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objektem pro hladinu Q50

[31] Grafické znazornéni pfi€ného profilu silni¢niho mostu na f.km 7,029
pro hladinu Q100

[32] Grafické znazornéni silni€niho mostu s pfi¢nymi profily pfed a za
objektem pro hladinu Q100

[33] Grafické znazornéni pfiného profilu Zelezobetonové lavky na F.km
6,904 pro hladinu Q1

[34] Grafické znazornéni zelezobetonoveé lavky s pfi€nymi profily pfed a za

objektem pro hladinu Q1

[35] Grafické znazornéni pricného profilu zelezobetonové lavky na f.km
6,904 pro hladinu Q10

[36] Grafické znazornéni Zelezobetonové lavky s pfi€nymi profily pfed a za
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objektem pro hladinu Q10

[37] Grafické znazornéni pficného profilu Zelezobetonové lavky na f.km
6,904 pro hladinu Q50

[38] Grafické znazornéni Zelezobetonoveé lavky s pfiénymi profily pfed a za
objektem pro hladinu Q50

[39] Grafické znazornéni pfi€ného profilu Zelezobetonové lavky na f.km
6,904 pro hladinu Q100

[40] Grafické znazornéni zelezobetonoveé lavky s pfi¢nymi profily pfed a za
objektem pro hladinu Q100

[41] - [44] Kompletni grafické znazornéni v 1D pohledu celého zajmového
uzemi Janovického potoka pro hladinu Q1, Q10, Q50 a Q100

[45] Znazornéni zaplavového Uzemi na podkladové mapé pro hladinu Qf1,
Q10, Q50 a Q100
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[1] Fotodokumentace Fi¢niho toku na
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[2] Fotodokumentace fi¢niho toku na f.km 8
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iho toku na r.km 8,5

[3] Fotodokumentace Fi¢ni

f.km 8,0

ho toku na

ficni

[4] Fotodokumentace
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[6] Fotodokumentace Fi¢niho toku na f.km 7,1
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[7] Fotodokumentace fi¢niho toku na f.km 6,7

[8] Fotodokumentace Fi¢niho toku na f.km 6,4
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[9] Fotodokumentace fi¢niho toku na f.km 6,0

[10] Vzniklé zaplavy v r. 2006 na uzemi Vaclavic (Usek na f.km 7,3) nachazejici se pred obci

Vaclavice
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[11] Vzniklé zaplavy v r. 2006 na Uzemi Vaclavic (Usek na F.km 7,1) nachazejici se u silni¢niho

mostu v obci Vaclavice

[12] Vzniklé zaplavy v r. 2006 na Uzemi Vaclavic (Usek na f.km 6,9) nachazejici se za

Zelezobetonovou lavkou na konci obce Vaclavice
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[13] Q 1 podélny profil

Janowickypotok  Plan: Janovicky potok 412412011
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[14] Q 10 podélny profil
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Janovickypotok  Plan: Janovicky potok 412412011
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[15] Q 50 podélny profil
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Janovickypotok Plan: Janovicky polok 412412011
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[16] Q 100 podélny profil
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[17] Grafické znazornéni pficného profilu silniéniho mostu na F.km 8,308 pro hladinu Q1

[18] Grafické znazornéni silniéniho mostu s pfiénymi profily pfed a za objektem pro hladinu Q1
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[19] Grafické znazornéni pfiéného profilu silniéniho mostu na F.km 8,308 pro hladinu Q10

Janovickypotok  Plan: Janovicky potok 412412011

[20] Grafické znazornéni silni€éniho mostu s pficnymi profily pfed a za objektem pro hladinu Q10
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[21] Grafické znazornéni pfiéného profilu silniéniho mostu na f.km 8,308 pro hladinu Q50

Janowickypotok  Plan: Janovicky potok 412412011

[22] Grafické znazornéni silniéniho mostu s pfiénymi profily pfed a za objektem pro hladinu Q50
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Janovickypotok Plan: Janovicly polok 412412011
sinni ot oo

& & )
T T '\

Erevaion (m

E) @ @ @

saten(ry

[23] Grafické znazornéni pfiéného profilu silniéniho mostu na F.km 8,308 pro hladinu Q100

Janovickypotok  Plan: Janovicly polok 412412011

[24] Grafické znazornéni silniéniho mostu s pficnymi profily pfed a za objektem pro hladinu Q100
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Janovickypotok Plan: Janovicky potok 412412011
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[25] Grafické znazornéni pfiéného profilu silniéniho mostu na F.km 7,029 pro hladinu Q1

Janouiclypotok  Plan: Janovicky potok 412412011
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[26] Grafické znazornéni silni€niho mostu s pficnymi profily pfed a za objektem pro hladinu Q1
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Janouickypotok Plan: Janovicky potok 42412011
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[27] Grafické znazornéni pficného profilu silniéniho mostu na F.km 7,029 pro hladinu Q10

Janovickypotok  Plan: Janovicky potok 412412011

[28] Grafické znazornéni silniéniho mostu s pfiénymi profily pfed a za objektem pro hladinu Q10
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[29] Grafické znazornéni pfiéného profilu silniéniho mostu na F.km 7,029 pro hladinu Q50

Janovickypotok  Plan: Janovicky potok 412412011

[30] Grafické znazornéni silniéniho mostu s pficnymi profily pfed a za objektem pro hladinu Q50
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Janouicypotok Plan: Janovicky potok 41242011
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[31] Grafické znazornéni pfiéného profilu silniéniho mostu na F.km 7,029 pro hladinu Q100

Janovickypotok  Plan: Janovicky potok 412412011

[32] Grafické znazornéni silni€niho mostu s pficnymi profily pfed a za objektem pro hladinu Q100
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[33] Grafické znazornéni pficného profilu Zelezobetonové lavky na F.km 6,904 pro hladinu Q1

Janouickypotok Plan: Janovicky potok 4/24/2011

[34] Grafické znazornéni zelezobetonové lavky s pfi€nymi profily pfed a za objektem pro hladinu Q1
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Janouickypotok  Plan: Janovicky polok 412412011
e ien

Erevaton (m)
¥

£ E) E) )
saion(n)

[35] Grafické znazornéni pfiéného profilu Zelezobetonové lavky na F.km 6,904 pro hladinu Q10

Janouickypotok  Plan: Janovicky potok 412412011

[36] Grafické znazornéni Zzelezobetonové lavky s pFicnymi profily pfed a za objektem pro hladinu Q10
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[37] Grafické znazornéni pficného profilu Zelezobetonové lavky na f.km 6,904 pro hladinu Q50

Janouiclypotok  Plan: Janovicky potok 4/24/2011
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[38] Grafické znazornéni Zelezobetonové lavky s pFicnymi profily pfed a za objektem pro hladinu Q50
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[39] Grafické znazornéni pficného profilu zelezobetonové lavky na f.km 6,904 pro hladinu Q100

Janowickypotok  Plan: Janovicky potok 412412011
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Gom

[40] Grafické znazornéni Zelezobetonové lavky s pFicnymi profily pfed a za objektem pro hladinu Q100

[41] - [44] Kompletni grafické znazornéni v 1D pohledu celého zajmového Uzemi Janovického
potoka pro hladinu Q1, Q10, Q50 a Q100
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Janouickypotok Plan: Janovicky potok 4/24/2011

[41] hladina Q 1

Janowiclypotok  Plan: Janovicky potok 4/24/2011

[42] hladina Q 10
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Janowickypotok  Plan: Janovicky potok 412412011

ccccc

[43] hladina Q 50

quququ

[44] hladina Q 100

[45] Z kapacitnich divodU je zaplavového Gzemi na podkladové mapé pro hladinu Q1, Q10, Q50
a Q100 soucasti pouze vytisténé verze.
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